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Exercise 1:

Download the Aster Dem data & Landsat imagery using the shape file
(AOD).

GIS Database Preparation

The essential dataset required for training is the terrain data (DEM). Additional datasets
that may be useful are aerial photograph (s) and land use information. The small portion of
the Uttarkashi is used to demonstrate, how to develop a 1D and 2D model for flood
inundation mapping using HEC-RAS, HEC-GeoRAS and ArcGIS.

The download_rs_data folder contains the following data as given below:
(1) Aster DEM
(i1) Landsat 8

(i) Aster DEM Data

ASTER is capable of collecting in-track stereo using nadir- and aft-looking near infrared
cameras. Since 2001, these stereo pairs have been used to produce single-scene (6(- x 60-
kilomenter (km)) digital elevation models (DEM) having vertical (root-mean-squared-error)
accuracies generally between 10- and 25-meters (m).

The methodology used by Japan's Sensor Information Laboratory Corporation (SILC) to
produce the ASTER GDEM involves automated processing of the entire ASTER Level-1A
archive. Stereo-correlation is used to produce over one million individual scene-based
ASTER DEMs, to which cloud masking is applied to remove cloudy pixels. All cloud-
screened DEMS are stacked and residual bad values and outliers are removed. Selected data
are averaged to create final pixel values, and residual anomalies are corrected before
partitioning the data into 1 degree (°) x 1° tiles.

The ASTER GDEM covers land surfaces between 83°N and 83°S and is comprised of 22,702
tiles. Tiles that contain at least 0.01% land area are included. The ASTER GDEM is
distributed as Geographic Tagged Image File Format (GeoTIFF) files with geographic
coordinates (latitude, longitude). The data are posted on a 1 arc-second (approximately 30—
m at the equator) grid and referenced to the 1984 World Geodetic System (WGS84)/ 1996
Earth Gravitational Model (EGM96) geoid.

While the ASTER GDEM 2 benefits from substantial improvements over GDEM 1, users are
nonetheless advised that the products still may contain anomalies and artifacts that will
reduce its usability for certain applications, because they can introduce large elevation errors
on local scales. The data are provided “as 1s” and neither NASA nor METI/ERSDAC will be
responsible for any damages resulting from use of the data.

The generation and basic characteristics of the ASTER GDEM were summarized in
a presentation by Tetsushi Tachikawa, et al., at the 2011 Institute of Electrical and
Electronics Engineers (IEEE) International Geoscience and Remote Sensing Symposium
(IGARSS).
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Data Set Characteristics

Tile Size 3601 x 3601 (1 degree by 1 degree)

Pixel Size 1 arc-second

Geographic coordinates Geographic fatilude and longitude

DEM output format GeoTIFF. signed 16 bits in units of vertical meters
Geoid reference WGS34EGMIG

Special DM values -9999 for void pixels, and 0 for 2ea waler body

Tile volume 25 MB uncompressed, 4-5 MB compressed
Coverage Morth 83 degrees lo south &3 degrees, 22 702 liles

Figure No 1: Overview of Aster Data

Download ASTER DEM of Study area
Open link https:/fearthexplorer uzgs, gov/. This website user interface is shown in Fig no 2.

Figure no 2: Earth explorer website

Required Registration

New users must register for their user account in Earth explore website, To register, select
Registration (Fig. no 3) button and enter the required information.



Usermame

Username Reguirements

Must be betwaen 4 snd 30 charsclorns
May contain sphadabic and numernc Chanmcions
May only contain the Tolowing spocal characters
peniod *
W sign @’
wundedscone ©_"
Confirm New Password dash ".* -

New Password
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Must contaen al last one nurmsenc charactes
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pound "
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' mart @ robod

Figure no.3: Registration window

USER Registration

If you have already completed user registration, enter your username and password and click
login button (Show in Fig. no 3)

After login, current screen moves to home page.
Step 1: Click on KML

Step 2: Select aoi.kmz from given directory D \gisdatabse\dem and open

Step 3: after that flash a popup window shows the aoi.kmz is uploaded, click on close. Show
aoi on MAP window in red color square box

Step 4: Go to data range, select date from 10/01/2011 to 10/30/2011 than go to Data Sets

DataSets | Addtional Criteria | Resuts

1. Enter Search Criteria

To narrow your search area. type in an address or place
name, enter coordinates or click the map to define your
search area (for advanced map tools, view the help
documentation), and/or choose a date range

x
PaihRow | Fealure

T « gisdatobase > Search de »

Search Criteria Summary (Show)

§  Orgenize > Newfolder =~ m @

@ OneDrive A Name Dte molified Type

S 08/16/201812417 ... KMZ
I ThisPC Ll

PreueﬁneuArea Shapefie | KML

“J 30 Objects
| [ Desktop

B Rornmente

1. Lat 30° 47' 14" N, Lon: 078° 22' 21"E e 1

v <

2. Lat:30°41'40" N, Lon: 078° 22 35" E /% B e i

3. Lat:30° 41' 46" N, Lon: 076° 29' 08" E iR

4. Lat 30° 47'25" N, Lon: 078° 28' 53" E /R

Result Options

Search from: |10/01/2011 =l to: 1013172011 =

aoi kmz
Search months: (all) -

Figure no 4: Search Criteria Summary

Step 1: Click on Data Sets

Step 2: Click on Digital Elevation
Step 3: Click on ASTER Global DEM
Step 4: Click on Result



Search Criteria Additional Criteria Results Search Criteria Data Sets Additional Criteria
2. Select Your Data Set(s) 4. Search Results
Check the boxes for the data set(s) you wani to search. | If you selected more than one data set to search, use
When done selecting data set(s), click the Additional the dropdown to see the search results for each specific
Criteria or Results buttons below. Click the plus sign data set.

next to the category name to show a list of data seis.
Show Result Controls

Use Data Set Prefilter (what's This?)

Data Set Click here to export your resulls » '
Data Set Search: ASTER GLOBAL DEM
+-Aerial Imagery | L
# Declassified Data 1 Displaying 1-10f1 @

P —— Coordinates:30.5 , 78.5
|| ¥ @ Kl ASTER GLOEAL DEM Acquisition Date;17-0CT-11

0 CONED TEDEM =
é"-EDNA v __IE @

I Digital Elevation LJ _ —‘ Entity ID:ASTGDEMV2_ON30E0TS

@ [E] GMTED2010 F 1w
RI¥ GTO @@ Download File Info = x

URL | htu:s:ﬂdds.D’.usgs.gow‘aumdata,'hsmﬂia:lfasterfdem,‘versionZ_Dﬂ.lNl'l’_r\|

Category | compressed v |+

Save As | eciraining \gisdatabase\d

Remember this path for "Compressed” category 22.00 MB
I C:\Wzers\acer\Desktop\subhhectraining \gisdatabase'dem), |
Description | 3 |
o
Download Later Start Download Cancel

Figure no 5: Information of ASTER Global
iiy Landsat 8

The Operational Land Imager (OLl) and Thermal Infrared Sensor (TIRS) are instruments
onboard the Landsat 8 satellite, which was launched in February of 2013. The satellite collects
images of the Earth with a 16-day repeat cycle, referenced to the Worldwide Reference System-
2. The satellte’s acquisiions are in an 8-day  offset to Landsat 7

(see hitps:/landsat.usgs.gov/acqguisition). The approximate scene size is 170 km north-south by
183 km east-west (106 mi by 114 mi).

The spectral bands of the OLI sensor, while similar to Landsat 7’s ETM+ sensor, provide
enhancement from prior Landsat instruments, with the addition of two new spectral bands: a
deep blue visible channel {(band 1) specifically designed for water resources and coastal zone
investigation, and a new infrared channel {(band 9) for the detection of cirrus clouds. Two thermal
bands (TIRS) capture data with a minimum of 100 meter resolution, but are registered to and
delivered with the 30-meter OLI data product. (See Landsat satellite band designations for more
information.) Landsat 8 file sizes are larger than Landsat 7 data, due to additional bands and
improved 16-bit data product (see hiips:/Mlandsat.usgs.goviwhat-files-are-included-when-i-

download-landsat-8-scene).

Landsat 8 Level 1 data products typically include data from both the OLI and TIRS sensor;
however, there may be OLlonly andfor TIRS-only scenes in the USGS archive. The first two
values of the Landsat 8 scene ID designates the data provided in each scene:




LC08_L1TP_003055_20170207_20170216_01_T1 = Combined (both OLI and TIRS data)
LOO8 L1TP 021047 20150304 20170227 01 T1= oLl data only
LT08_L1GT_137206_20170202_20170215_01_T2 = TIRS data only

A Quality Assurance (QA.LtIf) band is also included. This file provides bit information regarding
conditions that may affect the accuracy and usability of a given pixel — clouds, water or show, for
example. More information about the OA band can be found

at https:andsat.usgs.qgov/qualityband.

LandsatLook Images (full resolution files) are also available for Landsat 8 scenes, as they are for
all previous Landsat scenes. In addition to the Natural Color, Thermal, and Geographic
Reference bundle files available, Landsat 8 scenes also include a Quality .png file. This provides
a visual representation the QALif file. Details about Landsatlook images can be found

on hitps:Mlandsat.usgs.qovlandsatiook-images.

Nearly 10,000 scenes were collected prior to the satellite achieving operational orbit, from launch
to April 10, 2013. The earliest images are TIRS data only. These data are included in
the Landsat 8 OLI/TIRS C1 Level-1data set on EarthExplorer. While these data meet the
quality standards and have the same geometric precision as data acquired after achieving
operational orbit, the geographic extents of each scene will differ. Most of the scenes will process
to full terrain correction, with a pixel size of 30 meters. There may be some differences in the
spatial resolution of the early TIRS images due to telescope temperature changes.
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Figure No 6: Download Landsat Image



Exercise 2:
Preprocessing the download data

1. Re-project Dem Data

2. Data Format
a) Tiff for Catchment Delineation
b) Grid for Cross Section
¢) Float For Ras Mapper

3. Layer Stacking Landsat Imagery



1. Re-project Dem Data

Step 1: Add data b -

DAHEC_training\dem\ASTGTM2_N30EQ78\ASTGTM2_N30E078_dem.tiff
Step 2: Go to Arc Tool Box>>Data Management Tools>>Projections and
Transformations>>Raster>>Project Raster

=) & Projections and Transformations
= % Raster
#., Flip

Mirror

Value . Project Raster

= @ ASTGTM2_N3DEO78_dem.tif «
s

High: 6710 o
e
&

+, Register Raster
., Rescale
Rotate

#, Shift

#, Warp
Figure No 1: Add data & Projection

Low: 276

Step 2: Double click on Project Raster than open a pop up window see in fig no 3
Input Raster: ASTGTM2_N30EO78\ASTGTM2_N30EQ78_dem
Output Raster Dataset: reproject
Output Co-ordinate system: WGS_1984_UTM_Zone 44N
If not found projection go Projected>>UTM>>WGS 1984>>Northen
Hemisphere>> Select UTM 44 N

Spatial Reference Properties

XY Coordinate System 7 Coordinate System

= Type here to search . o *
Input Raster % v | [Type here o seardt v R Gyt
| ASTGTIMZ_N30EQ73_dem tif Rl =] @ By Favorites %
Input Coordinate System (optional) (5} Unknown
GCS_WGES_1584 T @ User Defined Polyconic
) WGS 1984 UTM Zone 44N
O t Raster Dataset
Aipu Rasiey Detese s . . () WGS_1984 UTM_Zone 43N
|C.Wsers\acer\Documems\,ArcGIS\De ult.gdbVASTGTM2_N30ED78_dem_ProjectR | = @ WGS_1984_UTM_Zone 44N
% Output Coordinate System C:E WG5_1984_World_Mercator
| [ [# ] Geographic Coordinate Systems
% Geographic Transformation (optional) + E ijedid Saniinale nter: )
|— = | Current coordinate system:
+ WG5_1984_UTM_Zone_44M ~
WEKID: 32644 Authority: EPSG
X Projection: Transverse_Mercator
false_easting: 500000.0
1 false_northing: 0.0
(¥ central_meridian: 81.0
L scale_factor: 0.9996
latitude_of_origin: 0.0
OK Cancel Environments, ., Show Help > > Linear Unit: Meter (1.0) -

Cancel

Figure No 2: Spatial Reference System



2. Data Format

a) Tiff for catchment delineation:
Step 1: Right click on reproject dem (show table of content)
Step 2: open a pop up window click on Data>>Export Data
Step 3: Click on Square (put value 30.0)
Step 4: Select Location: DAHEC_training\pre_processing\dem

Step 5: Name: dem1 (remember this dem use for catchment delineation)

Step 6: Format, select Tiff
Step 7: Save (automatically add in Table of content)

Table Of Contents Bx
EHeoe8 = ——— - == = —
5 S layers Export Raster Data - reproject
SE=
(=] Extent Spatial Reference
vl Bl Cony () Data Frame (Current)
I Hid % Remove (®) Raster Dataset (Original) O pata Frame (Curent)
= @
i B Open Attribute Table Selected Graphics (Clipping) Clip Tnside @ Raster Dataset (Original)
Joins and Relates 3
3 QOutput Raster
g ASTG| > Zoom Ta Layer [ Use Renderer [~] square: Cel Size (o, o): @ [ 30 | 30
Hv‘ ; Force RGE Raster Size (columns, rows): O 3253 2768
#  Zoom To Raster Resclution —
Use Colormap NoData as: | 32767 |
i Visible Scale Range » !
S = Name Property fad
= Bands 1
Edit Features » ||%s ExportData... Pixel Depth 15t
> Save As Layer File... : Uncompressed Size 23,59 MB
o o Ty Export Data Extent (left, top, right, bottom) ~ ( 210575,5384, 3433482.4203, 3000813685, 3320445.0604) ¥
4’ Create Layer Package... G %
P = '—J \fiew ltem Diescs Export raster data from this layer =
Bf Properties.. L to the format of your chaice. You oAt [ Bs\HEC _traininglpre_pracessing | [
can also choose other settings,
such as the extent of data, the Mame: W‘ Format: TIFF >
spatial reference, and cell size, =
AN T | Compression Quality 75
pr yp NONE | a0y
About export raster data Fa
Output Raster

Would you like to add the exported datato the map as a
layer?

Yes No

Figure No 4: Output Raster (Tiff Format)




b} Grid for Cross section:

All Step are same, so follow in Tiff format (from 1 to 5)
Step 6 Format, Select Grid (Name: dem2)

step T mave
Export Raster Data - reproject >
Extent Spatial Reference
() Data Frame (Current)
{®) Raster Dataset (Original) (O Data Frame (Current)
Selected Graphics (Clipping) Clip Inside @® Raster Dataset (Original)
Output Raster
[]use Renderer Square: Cell Size (o, cy): @ | 30,0 30
Force RGB Raster Size (columns, rows): () | 3233 3768
Use Colormap MoData as: | 32767
Mame Property L
Bands 1
Pixel Depth 32 Bit
Uncompressed Size 47,19 MEB
Extent {left, top, right, bottom) { 210576.5354, 3433452,4293, 3090513685, 3320445.0604) ¥
€ >
Location: | D:\HEC _training\pre_processing\dem | Ef-‘
Mame: | dem2 | Format: GRID W
Compression Type: Compression Quality 75
| NONE v] i

About export raster data Cancel

Figare No 5; Grid Format

¢} Float for RAS Mapper:
Step 1: Goto Are Tool Box>>Spatial analyst Tool>>Math>>Trigonometry>>Float

= & Math

] %1 Bitwise

& Logical

LR Trigonometric
#, Abs

#., Divide

*\ Bxp

“, Exp10

., Exp2

"E.}_ Float

Figure No &: Trigonotmetty

=+

[+



Step 2: Double click on float
Input raster or constant values: reproject

Output raster: dem3 (remember this format use for RAS Mapper)

Input raster or constant value

| reproject

Qutput raster

I_C Output raster

Look in:

1 dem W

S ASTGTM2_N30E0TS
VE dem tif

5 dem?2

i float

%% reproject

Name: | dem3| }

Save

Save as type!  paster datasets 'v'

Figure No 7: Float Format

3. Layer Stacking
Step 1: Open ERDAS Imagine 2015

=] ; = Untitled:1 - ERDAS IMAGINE 2015
Home Manage Data Raster Wector Terrain Toolbox Help

B e

|Contents|Metadzta

Google Earth

Contents.

E == 2D Vew #1
| Background

Figure No 8: ERDAS Imagine

Step 2: Click on Raster>>Spectral>>Layer Stack
Step 3: Input File (Click Open = ), go to directory

Cancel

Help ==

(DAHEC _training\pre_processing\landsat\[.C0O8_T.1TP_146039 20180425 20180502

_O01_T1)

File Type: Select Tiff

File Name: 1c08 11tp 146039 20180425 20180502 01 t1 bl.uf
Step 4: Click and open



Step 5: Click on ADD

Step 6: Repeat 4 & 5 step for add all bands
Step 7: In Layer Select All

Step 8: Go to output give the name layer_stack
Step 9: OK

Wait 2/3 min (according system configuration)

L Untitled:1 - ERDAS IMAGINE 2015
age Data Raster Vector Terrain Toolbox Help Google Earth
J R 7 DS & H a S ®m a 0 b @
Spectral| Mosaic Subset Geometric Reproject Check  noypervised Supervised IMAGINE ynercpectral Subpicel Knowledge  Zonal Change  peftacue Interferometry SEOMENIC Uirilities T
(1o - » & Chip~ Calibration~ Accuracy - - Objective - - Engineer | Detection Express™ - - Tools ™ -
4% Layer Stack - - - -
nput File:
i# Principal Component —————
" & Princinal € Layer Stack Inpuat File: [~tif) Cutput File: [*img) File Multiple
ur nverse Frincipal omg — =
& | Independent Compon|. <28 Stac] 1008 I1tp_148088_ 20180425, | ;5 | v|@@ | Look i3 1008 Mip 146038 20180425 ansns0z 01 1 | ] | [ B
e a e o X <in e =
& | Tesselad Cap bar? ) /[B] LCo8_L1TP 145033 20180425 20180502 01_T1_B1.TIF [ LC0G_L1TP_ oK
E ] e = [8] LC08_L1TP_148039_20180475_20180502_01_T1_B10TIF [ LCO_L1TF._
| Upeareibioh trerch file, — = T e ol [B] L0 L1TP_146039_20180425_20180502_01_T1_B11.TIF Cancel
B NG c ec_training/pre_processing/landsat/lc08_[tp_ 3_. I_
| Natncoke eror] | B2 071 1c08, i, 14E038_201 50425201 B0S02_01_(1_b1.tf % tgg:ﬂl?} jggjgﬁgl :gjé:ﬁgl :gggiglﬂgg 1:; Help
& RGEtoHS LU - - LT
= IKKDC"‘ [ LCO8_L1TP_146039_20180425_20180502_01_T1_B4.TIF
<# |HStoRGE L [B) LCD8_L1TP_146033_20180425_20180502_01_T1_B5 TIF e
% RGBIShaded Relief e Add Tl [B LC0A_L1TP_146039_20180425_20180502_01_T1_BE.TIF
& Spectral Mixer (on - ‘@ LCO8_L1TP_146039_20180425_20180502_01_T1_B7.TIF Goto ..
e = com|Data Type: [ LC08_L1TP_146039_20180425_20180502_01_T1_BS.TIF
s i< >
indg |nput; Unsigned 16 bit Output: Unsigred 16 bit ~
and Fila Traina: ||cns_ntp_145035_201am425_2mamsnz_m_n_m tif |
f’““l Dutput Options: :
imp| Files of type: | TIFF [
acci ) (&
@ Union () Intersection [J1anare Zera in Stats areyscale - 73921 Rows » 7781 Columns w1 Band(s)

Balch Al ..
Cancel Yiew Help
Qutput File:
File
Look irc| 3 landsat il
Jl;] LCO3 L1TP_146039_20180425_20180502_01_T1 0K
Cancel
Help
Recent ...
Goto ...
File name: | laver_stack
Files of type: | IMAGIME Image [*.img] ol ¥

1 Files, 1 Subdirectories, 0 Matches, 1342151968k Bytes Free

Figure No 9: Layer Stack window



a) Open Raster Layer
Step 1: Rightclick 2D View #1
Step 2: Open Raster Layer...
Step 3: Select Layer To Add
Location: D:A\HEC_ training\pre_processing\landsat
File of Type: change in imagine(*.img)
Name: layer_stack.img

Contents o= 20 Wiew H

E-[v] IV I e M
| Backgl Bl Open Raster Layer.. Select Layer To Add:
Open Vector Layer.. File Raster Options  Multiple

RlpeniAON Eaver Look, in:!a landsat

(CJLCOS_L1TP_146039_20180425_20180502_01_T1 Dk

Open Annotation Layer.

Open Photogrammetric Project..

Open Point Cloud Layer., )
Open TerraModel Layer.. Help
Three Layer Arrangement.. ] |
Multi Layer Arrangement., Recent.. |
New AQI Layer Gata...

Mew Annotation Layer

BRERBEEEREBE

Mew Vector Layer..

e

Mew Photogrammetric Project.. File mame:  |laver_stack.img

Files of bype: | IMAGINE Image [*ima) | _*3 &

;Eruecolor: ?951 Rows » 7781 Columnz # 7 Band(z)
k.

Figure No 10: Open Image

by Change band combination
Step 1: Go to Raster select multispectral
Step 2: Select layer Son 1, Layer 3 on 2, Layer 2 on 3

r:" g .5 . ."l Bl -l ol Rmul

Home Manage Data Raster Vector Terrain Toolbox Help Google Earth Multispectral Drawing
- Discrete DRA ~ . sat4 TM - -
e <P Discrete » TTTE - O T O - Landsa M Layer s B Mearest Ne

ij): L R Custom v . Layer.3 =

Acjust || BT o (Of - (8 Fittering~ i
Radior{n iy ol Ql 41 Filtering W oy - Pixel Transparnt
Enhancement Brinhtness Contrast Sharpness Bands u Viey
Contents 4 x 2D View #1; layer_stack.imag [;Layer_5) Layer_3)[ Layer_2)
23 = 2D View #1
5 ¥ @

! Background

Figure No 11: Change Band Combination



Exercise 3:
Catchment delineation & LULC Classification

1. Catchment Delineation
a) Apply Spatial Tool (Arc-Hydro)
b) Fill
¢) Flow Direction
d) Flow Accumulation
e) Stream Network
f) Raster to Polyline (conversion)
g) Define Outlet (Snap Pour Point)
h) Watershed Boundary
i) Convert Raster to Vector (Conversion)
1) Calculate Area

2. LULC Classification

a) Define Signature
b) Supervised Classification



1. Catchment Delineation
a) Apply Spatial tool (Arc-Hydro)

In “Arc Tool box™, click on S patial Analyst Tools>>Hydrology as shown in Figure 1. Then
apply following steps for creating stream network and watershed delineation.

= &§ Spatial Analyst Tools

7 & Conditional

¥ s Density

5 @ Distance

= Es Extraction

[+ ®s Generalization

7 B Groundwater

= &5 Hydrology
#., Basin
i, Fill
;z. Flow Accumulation
#.. Flow Direction
%, Flow Length
. Sink
“‘-.\_J Snap Pour Point
#, Stream Link
#%,, Stream Order
‘J.\-. Stream to Feature
“‘—.\_J Watershed

Figure No 1: Spatial Analyst Tool

by Fill: This function fills the sinks in a grid. If cells with higher elevation surround a cell,
the water ig trapped in that cell and cannot flow. The Fill Sinks function modifies the
elevation value to eliminate this problem. The main function of thig tool is to remove
imperfections in the DEM to enable water flow to the watershed outlet,

Step 1. Double click on “Fill” option.

Step 2: Fill window will appear. Select the dem file (deml tiff) in “Input surface raster”
option and give the name of output file in “Output surface raster” (eg. Fill_deml) ag shown
in Figure 2.

Step 3: Leave the default options for z limit (optional) unchanged. Click OK.

Step 4: After the process is complete a filled DEM (fill_dem1) will be added to the map
document.

& Input surface raster

| =

& Output surface raster

Z limit {optional)

¥

[l

Figure No 2: Fill Dem



c)  Flow Direction: This fimetion comptes the flow direction for a given grid.

Stepl: Double click on “Flow Direction” tool,
Step 2 Flow Direction window will appear.
[nput Surface Easter: fill_dem]
Output flow direction raster: fdir_dem1
Step 30 Leave the default options for Catput drop raster (optional) unchanged. Click OK.

Step 4 After the process is complete a fdir_dem1 file will be added to the map document
(show in figure no 47,

#.. Flow Direction - O x

® Input surface raster

| =l e
% Output flow direction raster
[ ] Force all edge cells ta flow outward (eptional)
Qutput drop raster (optional)
Figure No 3: Flow Direction
Table Of Contents o = RESTES PR = TR
82 <8 5
=l = Layers
-
B
2
4
k=
[l
. 32
. 54
N 128
= fill_dem
=l dem1.tif
Value
High : 7076
Low : O

Figure Mo 4: Output fdir_dem1

d) Flow Accumulation: The function uses the flow direction grid to compute the
accumulated mamber of cells that are draining to any particalar cell in the DERM.

Step 1: Double click on “Flow Accumulation” tool,
Step 2: Flow Acenmmlation” window will appear.,
[nput flow direction raster; fdir_dem1



Cuatpiat aceumulation raster: face dem1

Step 3. Leave the defanlt options for input weight raster and output data type (float)
unchanged. Click K,

Step 4 After the process is complete a face_deml file will be added to the map docuament.

"‘-;. Flow Accumulation — O 5

% Input flow direction raster

—k

| RAN =
& Output accumulation raster

| =]

Input weight raster (optional)

| : =l

Output data type (optional)

| FLOAT v|

Figaure No 5 Flow Accumulation

€) Stream Network: Eecause the flow accumulation gives the number of cells {or area) that
drain to a particular cell, it can be used to define a stream. It iz assumed that a stream is
formed when a certain area (threshold) drams to a pomt. This threshold can be defined by
nsing the mamber of cells in the flow accumulation grid. If we assame an area of lkm? as
the threshold to create a stream, the mimber of cells corresponding to this threshold area
iz 1111 {1000000/(30*30%) az the resolation of ASTER DEM iz 30m.

Step 1! select Spatial Analyst>> Map Elgebra»>Raster Calculator

= & Spatial Analyst Tools
# &y Conditional
& By Density
# & Distance
[ Wy Extraction
# &y Generalization
+ By Groundwater
= & Hydrology
[+ & Interpolation
# &y Local
= & Map Algebra
#., Raster Calculator

Figure No 6 Map Algebra



step 2: “Raster Calculator”™ window will appear. Write the function in Raster Calculator
as given below

Give formula in expression Setnull ([face_dem1] < 1111, 1)

£ a 5er\.r.erTc|a|s #., Raster Calculator = O X
=) B Spatial Analyst Tools

= ﬁ! tonciional Map Algebra expression

[ &y Density

i & Distance Layers and variables L] Conditicnal ~

& & Extraction > watershed T Can

® &y Generalization <>snap|:|oint 7 8 9 ! g || | | g P

= &y Groundwater & o i s | o = i ||| sethul

@ & Hydrology Crface_deml i Math

@A &: Interpolation <>fdir_dem1 1 = 3 o o ||lz=|| = o

= & Local ol dem1 Exp

= & Map Algebra $rdem L tf w 0 . 2 NERAT i | . v

#., Raster Calculator o o '

= By Math SetNull(face_dem1” < 1114,1)

[ B Multivariate

# & Neighborhood

= % O\fer]a}r Qutput raster :

[ g Raster Creation |C:‘-,leers‘-pcer‘n,Domments'-,E\rcGIS'l.DefauIt.gdb'-rastermlcl | B

& &y Reclass

® & Solar Radiation

i &y Surface

i & Zonal | Cancel Environments. ., Show Help ==
) B Spatial Statistics Tools

Figure No 7: Raster Calculator
Step 3: Output Name: Stream
f) Raster to Polyline {conversion):

Step 1: Go to Arc Tool Box Conversions Tools>>From raster> >Raster to Polyline

L g amiugrupiiy s s

= @ Conversion Tools

[ @ Excel

= &« From GPS

& & From KML

= & From Raster
#.. Raster to ASCII
#., Raster to Float
#.. Raster to Point
#.. Raster to Polygon

™ Raster to Polyline

#. Raster To Video

Figure 8: Conversion Tool



Step 2: “Raster to Polyline” window will appear. Select the stream file (output file of
previous function) in “Input raster” option and give the name of output file in “Output
polyline features”.

Input Raster: Stream
Output Polyline Line Feature: Drainage

& Ractertn Po

@ Input raster
| =l &
Field (optional)
| v|
@ QOutput polyline features
| N=
Background value (optional)
E= 9|
]‘\‘Em-num dangle length (optional) ‘
0

[ Simplify polylines (optional)

Figure No 9: Raster to Polyline

After the process is complete a drainage.shp file will be added to the map document.

=] Lavers)

= [ outlet

= .d}ainage

= [ catchrment
=

= [ watershed
| N

= [ snappoint
1

= stream
| &

[ facc_dem

= [ fdir_deml

= [ fill_dem1

= [ deml.tif

Value

High: 7076

Low: 0

i F [ , =

VA s A 5 Syt .
It e |

. : ~ : s
;

T, o

RNV SPTPES Sy B SN

Figure No 10: Drainage Network




g} Define Outlet:
Step 1: Add Point shape file (Mame: outlat.shp)
Step 2: Open Snap Pour Point
[nput raster or feature pour point data: outlet .chp
[nput accurmalation raster: face dem]

Cufputf raster: Snappoint

[, 3 .
%, Snap Pour Poin [

% Input raster or feature pour point data

| =l |
Pour point field {optional) |
% Input accumulation raster
| =l |
% Output raster
| =
Snap distance
0]
Figure No 11: Snap Pour Point
h) Watershed:
Step 1. Double click on Watershed
Input flow direction raster: fdir_dem1
[nput raster or feature pour point data; SnapPoint
Catput raster: Watershed
Step 2: Ok
. Watershed — O
% Input flow direction raster _
| =l &
% Input raster or feature pour point data _
| =1 &
Pour point field {optional) |
2 Output raster _
I | b

Figure 12: Watershed



i) Raster to polygon (Conversion):
Step 1: Click on Conversion>>From Raster>>Raster to Polygon

= & Conversion Tools

[ B Excel

[ & From GPS

= By From KML

= & From Raster
#.. Rasterto ASCI|
#.. Raster to Float
"r\\ Raster to Point
#.. Raster to Polyline
#., Raster To Video

Figure 12: Conversion {raster to polygon)

Step 2: Rasgter to polygon
Input raster: watershed

Catput polygon featare: Catchment

e
% Input raster
| R =
Field (optional)
& Output polygon features
=
Simplify polygons loptional)

Figure No 13: Raster to Polygon
j) Calculate Area:

Step 1: Right Click on Catchment and open Attribute table
Step 2: go to menn bar and click {show a column window)

Step 3: Click on Add field (Name: area, Type: float)



= Of Contents 1 x File Edit View Bookmark
8o8ia DEBE& 8
= = Layers @lelo ™
- B | Ar o
= O outlet 1% v U 3L VAN TS | e s
3] Table
=2 drainage -{ | B By -/. T
S W@ - 5 B8 Find and Replace...
[ L BL  Select By Attributes... Llias lang
g [0 water X FRemove 425654 | ET8° 56' 45.339" N31* 2 61507
1 B el
” D:appE Open Attribute Table | T Switch Selection Add Field %
= Join S *
I s 7 Open Attribute Table m Sclecall Name: area
= G oo >
H str:an S Open this layer's attribute table. I G .
= f- Shorteut: CTRL + double-click Turn All Fields Or) Add Field Type: | Flot |
= okl Visilf layer name OR CTRL + T, » > ; ] Lo |
& O fdicd Show Field Aliase|  Adds a new field td Field Propertics
@ O fde | nSymiolboech Arrange Tables a | E l
=0 derr\1{'| Selection Y Restore Default Column Widths [Scale [0 |
a
Hid Label Features Restore Default Field Order
I Edit Features 4 loins and Relates 4
Loy Related Tables 3
dllj Create Graph...
Convert Symbology to Representation... Add Table to Layout |
Cancel
Data * Il = Reload Cache -
. Save As Layer File.., % Brint...
'i;') Create Layer Package.., Reports »
™ Properties... Export...
i it
Appearance..
| Tl o e
Figure No 14: Catchment Attribute Table
Step 4: Right click on area (open a pop up window > >select calculate geometry than
click on Yes
| area | ) z ;
»-----------.:1 = Sort Ascending Calculate Geometry X

Sort Descending
Advanced Sorting...

Summarize...

Statistics...

Field Calculator...

Calculate Geometry... |

[C] Dont warn me again

‘fiou are about to do a caleulate outside of an edit session. This method iz faster than caleulating in an edit
session, but there is no way to undo pour results once the calculation begins, Do vou wish to conlinue?

Na

X

Tum Field Off

Freeze/Unfreeze Col Calculate Geometry

Delete Field

Populate or update the values of

this field to be geometric values

Properties...
roirb

bakle ramvasmmbe -

derived from the features that the

Figure No 14: Calculate geometry



Step 5: Open antomatically pop up window Caleulate geometry window
Property, Area

Units: Square Kilometers [5q km]

Calculate Geometry >
Property: Area e
Coordinate System

(®) Uze coordinate system of the data source:
[PCS: WGS 1984 UTM Zone 44N

(_JUsze coordinate system of the data frame:

GCS: WG5S 1984

Units: Square Kilometers [sq km] b

Calculate selected records only
About caloulating geometry Camcel

Figare Mo 13! Area Caleulate




2. LULC Classification

Erdas Imagine 2015 software iz used for preparing Landuse/ cover map . For this, supervizsed
clazsification of Landsat 8 OLITIRES image will be carried out to classify the image in o
clagses, namely forest, urban, fallow, barren ete,

Right click on 2 D view# and select add raster data DAFEC traininglandise

| = [§

Figiure No 16: ERDAS Imagine Interface

Define Signature
Step 1: Goto Raster>>Supervised classification>>Signature Editor

Step 2: Belect aoitoolbar and select o polygon create feature (water signature at least 10 to
25 class create.
In Viewer #1 use Zoom icon to Zoom to a theme

. | o
Step 3: create new signature from aoi :

Add more signatures for same class for others part of image using procedure described in
steps
Select all sighatire of same class as shown in Figl® and click on Merge Selected

Signature 54 option. After that delete selected signahires and give the class name Water,



ey,

gof+lEa g va

Add atleast 10 class for each (ex-forest, water ete)

Step 1: Eelect all Clazzes

Step 2: Click on merge

Step 3: Give the class name (Ex-Water)

Step 4. Save gignature file ag DAHEC trainin p\Classifiactionisignd

= Sigrature Felfor (Mo Filsl - .| e = Seve Signatuee File & A

File [Edd Wew Evilisls Fesbure
1 Sighhas Fies [“aig)

Lnaify
0 wdu]@ i va &

Do ® > Signanan Mame Cokn | Fed  Gwen:  Bue  Mabw | Ode| Cound | Fob (P(|H & F5 _] pere
Clazz 4 N om0 D6 oS M M 13 100 o
Cleas 25 o0 (e e B X B OL0E v v
Clin 26 @ = DGl DA OB 06 . BT (DIW v v @
Chier 27 0O00 BEM, 0NN I W EE 100 e
Ciase 28 B o0 DI GEN B 2R BM TOIve v e
Tl 23 B 0000 0a G4 28 2 4508 1000w v v :
Cleii X0 =3 Lk
[ 3% waiw o L T
— — whiich Sgnabuas
@- | Al Seecind

Catsl Hal

Figure No 18: Signature Editor

Supervised classification

Click Classify-Supervised menu to open Supervised Classification dialog box.
Step 1: Select Raster in mam tool box

Step 2: Select supervized classification

Step 3: Input raster, input Signatuare and give classified File supervised (output)
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Figura no 11: Classified Image



Exercise 4:
Delineate Cross Section from DEM Data

1) Save Arc Map Document
Step 1: Click on File>>Save As
Step 2: Save As X_section

Q x_section - ArcMap

File | Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help
0 Mew.. @ CorleN o ] B/ Ja - : Editor- 1]
- o
B Open.. Chit+) Kk O B3 - | Preprocessing v Project Setup » Basin Processing ™ Characteristics » Parameters ~
@ s Sl Watershed Processing - Attribute Tools ~ Network Tools ~ ApUtilities ~ =%, = - RAS Geometry = RAS Mapping~ 5¢ ¢ || F o=
[ Save As... ~
1 x
Save A Copy... e Q Save As w
Share As 5 i il
ave the current map with a new i G FEA & cofmle| X
Add Data name or to a different location. | = | e ? | ar
»
E\. Sign In... i MName Date modified Type
HE ArcGIS Online... : Q_le_section 08/16/2018 02:26 ...  ArcGIS An
Quick access
Page and Print Setup...
@ Print Preview... n
& Print.., Desktop
Export Map...
Analyze Map... g ﬂ_
Libraries
[ Map Document Properties...
1 CAUsers\acer\D...\x_section.mxd {%
2 C\Usersh\a..\catchment_del.mxd This PC
3 Di\xsec_parbati\parbati.muxd a
4 Di\xsec_parbati\xsec_parbati.mxd = < >
MNetwork
5 CAL: Deskto...\batt.md
\Users\acer\Deskto...\batt.mu File name: | V| I Tave I
6 D:\bhatt\1.mxd ;
Save as type: | AreM v Cancel
7 DvmkgsirTvmbkagsirT.mxd b i Dot St
8 D\RAL_SIR\amit\a3.mxd
G DARALSIR amit2ya2.mxd
Exit Alt+F4

Figure No 1: create X Section

Note: Since Hec-GeoRAS uses functions associated with ArcGIS Spatial Analyst and 3D
Analyst extensions, make sure these extensions are available, and are enabled

Clicking on Customize —2Extensions and checking the boxes (if they are unchecked) next to
3D Analyst and Spatial Analyst as shown below (Fig. 2 & 3). Close the Extensions window



Extensions >

Select the extensions you want to use._

ArcScan

Geostatistical Analyst
Metwork Anakyst

Publisher

Schematics

Spatial Analyst

SWAT HRU Delineator
SWAT Project Manager
SWAT Watershed delineator
Tracking Analyst

NOOONERRED

Descnption:

3D Analyst 10.22
Copyright 21995-2014 E=n Inc. All Rights Reserved

Provides tools for surface modeling and 3D visualization.

[Cese ]

Figure No 2: Extension

Load the HEC-GeoRAS toolbar into ArcGIS by clicking on Customize=# Toolbars and click on
check box of HEC-GeoRAS option as shown below (Fig.3):

a %_section - ArcMap 3D Analyst
File Edit View Bookmarks |Insert Selection Geoprocessing | Customize | Windows _l:!_n_:_lp Advanced Editing
NDadas B x| b Toolbars 3 | AH Profile Toolset
= - Extensions... Animation
RAEN@ I ¢ -k @
: . 3 . ; Add-In Manager.., Apltilities
Terrain Preprocessing * Terrain Morphology ~ Watershed Processing ~
Table OF.C a x Customize Mode... Arc Hydro Tools
- :’-"“‘!"3 Style Manager ook
w8 g S ArcSWAT
rciviap 10NS...
= [EEn £ COGO

Data Driven Pages

Data Frame Tools
Distributed Geodatabase
Draw

Edit Vertices

Editor

HEC-GeoHMS
HEC-GeoRAS

Irmage Classification

B I

Impact Analysis Tools

Figure No 3: Add tool bar
Note : The HEC-GeoRAS toolbar has four menus (RAS Geometry, RAS Mapping, ApUtilities,



Help) and sever toolabuttons (Assign RiverCode/ReachCode, Assign
FromStationToStatiorn, Assign Line Type, Construct XE Cutlines, Plot Cross Section, and
Aszzign Levee Elevation) as shown in circles and boxes, regpectively in the Fig.5.

RAS Geometry~ RAS Mapping~ < 8¢ |l &F = < £ Aplhilities~ Help -

a) Setting up Analysis Environment for HEC-GeoRAS

Click on Add button G- i ArcMap and browse to dem2 to add the DEM to the map
document ag shown in Fig. 4. You must have the same coordinate system for all the data and data
frames used for Geo-RAS project. Becanse dem? already has a projected coordinate system, if is
applied to the data frame

Add Data X

Lookin: | cross_section vealwad E-82ao®

|i_] #_section.mdb

Name: [ dem2 | lTl

Show of type:  patasets, Layers and Results ~ ~ Cancel

Figure no 4: Add Data

Click on RAS Geometry=>Layer Setup, Select dem? as the single Grid in the Required
surface tab, and click Ol .(see in figare no 5)



J-Tafion
RAS Geometry =
Create RAS Layers

SWAT Project Setup = Waterched Nelineatne v HRLI Anaheicr Write Inniit Tahlas » L =

) EE: Layer Setup for HEC-RAS PreProcessing
RAS Mapping ~ 15< gif

3 Required Suface Required Layers  Optional Layers  Optional Tables

| Layer Setup

Bridges/Culverts
Inline Structures
Lateral Structures

Storage Areas

Export RAS Data
Terrain Tiles

Utilities

RAS Layer Setup
RAS Layer Setup

Ineffective Flow Areas >

Blocked Obstructions

Sterage Area Connections 4

(@) Single

() Multiple

Terrain Type
Select Terrain

OTM Tiles Layer

[] Apply HEC-GeoRAS Symbology

O T
[dem2

Mol

@ GRID

oK Help

Cancel

Figure No 5: Layer Setup

In HEC-GeoRAS, each attribute is stored in a separate feature class called as RAS Layer. So
before creating rniver attributes in GIS, let us first create empty GIS layers using the RAS

Geometry menu on the HEC-GeoRAS toolbar.

b) Create Stream Centre line

Click on RAS Geometry =Create RAS Layers (Fig.6). You will see a list of all the
possible attributes that you can have in the HEC-RAS geometry file. Click on individual

attribute to create a single layer at a time.

S eoRA
RAS

Geometry ~| RAS Mapping > 5< 2w

i'_ 1] & — -:_;L;"J ApUtilitie

Create RAS Layers

|

Layer Setup

Stream Centerline Attributes

XS Cut Line Attnbutes
Manning's n Values
Levees

Ineffective Flow Areas

Blocked Obstructions

Bridges/Culverts
Inline Structures
Lateral Structures
Storage Areas

Storage Area Connections

— = e o

b4

Yy v¥vy¥uw-:

Yy ¥ vy ¥vrv

Stream Centerline

[ o

Stream Centerline

Strearm Centerline

XS Cut Lines
Bridges/Culbverts
Ineffective Flow Areas
Blocked Obstructions
Landuse Areas

Levee Alignment
Levee Points

Inline Structures
Lateral Structures

Storage Areas

Figure No 6: Stream Line creation



Click on RAS Geometry >>Create RAS Layers>> double click on Stream Centerline. Create
Stream Centerline Layer window will appear (Fig 7), accept the default names (eg. River), and
click OK.

Create Stream Centerline Layer acknowledge window will appear (Fig.7). Click OK

Create Stream Centerline Layer
@ Create Stream Centerline Layer X

| Stream Centerline layer created successfully!

Stream Centerline [-I_:ﬁver kil
Complete layer by digitizing features.

[OK ]| Helo | Canca

oK

Figure No 7: Stream Centre line Name (Feature Name)

c) Bank Line
Click on RAS Geometry =>Create RAS Layers—> double click on Bank Lines.
Create bank lines window (Fig.8) will appear, accept the default names (eg. Banks),
and click OK.
Create Bank Lines acknowledge window will appear (Fig.8). Click OK

pe

Create Bank Lines

-

@ Create Bank Lines

Bank Line layer created successfully!
Complete layer by digitizing features.

Bank Lines JEﬂ“ks

oK Help Cancel

OK

L9

Figure No 8: Bank Name

After creating RAS layers, these are added to the map document with a pre-assigned symbology.
Since these layers are empty, our task is to populate some or all of these layers depending on our
project needs, and then create a HEC-RAS geometry file.

d) Creating River Centerline

o Let us first start with river centerline. The river centerline is used to establish the river

reach network for HEC-RAS. The Bhagirathi River flowing from east to west.



e (lick on button to add the satellite image (e.g layer_ stack.img) in ArcMap
. & |
mterface. ——

e  Right click on layer_stack.img file and click on Properties (Fig.9).

e Layer properties window will open. In Symbology tab, select band combination as 4 3 2.

Click OK.

We will create/digitize the center of the river, and aligned in the direction of flow. Zoom-in

to the most upstream part of the Bhagirathi reach to see the main channel.

S
B £ Layers & | ArcToolbox
B B XSCutLines wv | |- @ 3D Analyst Tools
A
= v | |- & Analysis Tools
bid
B @ Flowpaths o ||® @ Cartography Tools
= @ @18 Conversion Tools
o # Banks @ | T & Data Interoperability
= - @ Data Management T
nd @G ding Tool
o ® River = & eocoding Tools
_ 5 &1- @ Geostatistical Analys'
& iandsat 13.29.05 2013 ] = | |= & Linear Referencing Tt
RGB Copy ;
B Red: Band_1 ¥ Remove :‘O
B Green: Band_2
I Blue: Band_3
B srtm_dem_utm Joins and Relates »
Value
Is
High: 2579 & Zoom To Layer =
@ Zoom To Make Visible bo
Low:1037 £ Zoom To Raster Resolution
Visible Scale Range »
Data »
Save As Layer File...
E——

Figure No 9: Band Combination Image

e (Create the river centerline (in River feature class), Go to Editor = Start Editing (Fig. 10).
In editor menu select B create features tool, select River as shown in Fig. 11.
for dizitization.

(Note: While digitizing the centerline, make sure that you leave some space between the
boundary of the dataset and the beginning/ending of your centerline.)

Editor~|

[ 7 start Editing

Start Editing

Start an edit session so you can
edit features or attributes.

@ Press F1 for more help.




Create Features S
-,5'5 - <Search> -

Click here to see templates not listed. bl

o)

River
~— River

Figure no 10: Start Editing

Start digitizing the river centerline from the upstream end towards the downstream. When you
reach on the end point, double click to complete the centerline for the reach. After finishing
digitizing the Bhagirathi Reach, Go to Editor = save the edits. Then click on Stop Editing.

EC-GeoRAS X
RAS Geometry = RAS Mapping~ ¢ 5¢ |l & < < &2 ApUtilities~ Help~

Figure No 11: Mapping

After the reach is digitized, the next task is to name them. Each river in HEC-RAS must have a
unique river name, and each reach within a river must have a unique reach name. To assign
names to reaches, click on Assign RiverCode/ReachCode button to activate it as shown
below in Fig. 12

EC-Ge e : : = ¥ X|
RAS Geometry » RAS Mapping | | & < < &2 aputiities ~ Help ~

fssign RiverCode and ReachCode to River

Figure No 12: River ID Name



With the button active, click on the Bhagirathi River reach. Assign River and Reach code
window will open, Assign the River and Reach name as River and Reach (Fig. 13),
respectively, and click OK

River Name [river

Reach Name |reach

OK

Figure No 13: River Name & Reach Name

Now open the attribute table of the River and you will see that the information you just provided
on river and reach names is entered as feature attributes as shown below (Fig 14)

Table o x
SRR RRRCR L
River X
Shape* | OID* Shape_Length | HydrolD | River | Reach | FromNode | ToNode | ArcLength [ FromSta | ToSta
» | Polyline 2 10858151132 2 | River Reach | <Null= <Null> <Nuit> ;«:Null.:' =huli=
(T 1% M ﬁ {0 out of 1 Selected)
River

Figure No 14: Attribute Table (River)

¢ Also note that there are still some unpopulated attributes in the River feature class
{FromNaode, ToNode, etc.).

Before we move forward let us make sure that the reaches we just created are connected, and
populate the remaining attributes of the River feature class. Click on RAS.

e) Create Topology, Length
and RAS Geometry w RAS Mapping ¥ i< 3¢ 1| & « < ¢ apuili Blevation profile

Create RAS Layers b = )

Geometry >

o] : ArcToolbox i
Stream Layer Setup wu ----& 3D Analyst Tc  Centerline
) - 3 m S Anaheic Toal Atrbutes—= All

(Fig.1 5) Stream Centerline Attributes P Topology _
XS Cut Line Attributes 3 Lengths/Stations ;
€
Manning's n Values 3 Llevations 3
t
Levees ] All |
Ineffective Flow Areas b i a Linear Referel
Blocked Obstructions ] o - MOb_"e_ TODI?
& Multidimensi
Bridges/Culverts b || # || 5-8 Network Anal



Figure No 15: Create Topology. Length & Elevation

All Steam Tools dialogue window (Fig. 16) will appear. Confirm River for Stream Centerline
and dem2 (Give name) for Terrian, River3D for Stream Profiles, and click OK

Stream Centerlin |Rhf9r

TN | Il Batch process on stream tools completed successfully!

Stream Profiles  |River3D

oK OK I

Figure No 16: All Stream Data set

This function will populate the FromNode and ToNode attribute of the River feature class. This
will populate all attributes in River, and will also create 3D version (new feature class) of River
centerline called River3D. Now open the attribute table for River (Fig. 17), and understand the

Attributes ﬁ River n

Shape * OBJECTID * Shape Length HydrolD River | Reach | FromNode | ToNode | ArcLength From5ta | ToS5ta
Polyline 11 10625 444188 3 | river reach 1 10625.444 10625 44

-
ra
=

Record: il jl al _>|ﬂ Show; W Selected | Records (0 out of 1 Selected) Options v|
LN - -

meaning of each attribute

Figure No 17: Attribute Table



Note: HydrolD is a unique number for a given feature in a geodatabase. The River and Reach
attributes contain unique names for rivers and reaches, respectively. The FromNode and
ToNode attributes define the connectivity between reaches. ArcLength is the actual length of
the reach in map units, and is equal to Shape Length. In HEC-RAS, distances are

represented using station numbers measured from downstream to upstream. For example,

each river has a station number of zero at the downstream end, and is equal to the length

of the river at the upstream end.

Close the attribute table, and save the map document

f) Creating River Banks

Bank lines are used to distinguish the main chammel from the overbank floodplain areas.
Information related to bank locations is used to assign different properties for cross-
sections. For example, compared to the main channel, overbank areas are assigned higher
values of Mamning’s n to account for more roughness caused by vegetation. Creating
bank lines is similar to creating the channel centerline, but there are no specific guideless
with regard to line orientation and connectivity - they can be digitized either along the
flow direction or against the flow direction, or may be continuous or broken.

e To create a bank line (in Banks feature class), follow the same digitization procedure by
selecting bank feature in Target and straight segment tool. You can have a
single bank for the whole reach. One the right hand side, however, you cannot cross the
stream so vou will need two separate lines for the right bank of the Bhagirathi River.
Digitize banks for Bhagirathi reach (Fig. 18) and save the edits and the map document.

Figure No 18: Channel Mapping

g) Creating Flowpaths

The flow path layer contains three types of lines: centerline, left overbank, and right over bank.
The flow path lines are used to determine the downstream reach lengths between cross-sections
in the main channel and over bank areas. If the river centerline that we created earlier lie
approximately in the center of the main chamnel (which it does), it can be used as the flow path
centerline

¢ Click on RAS Geometry -»Create RAS Layers—> double click on Flow Path
Cenerlines. Create Flow path Layer window (Fig. 19) will appear. Click Yes.

e (reate Flow paths window (Fig. 19) will appear, accept the default names (eg. River



in Stream Centerline and Flow paths in Flow paths). Click OK.

o (reate Flow paths acknowledge window (Fig. 19) will appear. Click OK

Create Flowpath Layer 2 Create Flow P

Stream Centerline :]
Flow Paths |FIonaths

The stream centerline is defined.
Do you want to copy the existing stream
centerline shapes into the flowpath layer?

‘ oK Help ‘ Cancel |‘

Figure No 19: Flow Path

To create the left and right flow paths in Flowpaths feature class, start editing. Set Flowpaths
feature class in Target. Open attribute table of Banks feature class (Fig.48). Select both banks
lines. Click on Copy tool then click on i) Paste tool

[ Attributes of Banks s ' =
Shape* | OBJECTID* Shape _Length HydrolD
¥ | Polyline 1 10677 326646 5
Polyline p) 10673.43919 3

Figure No 20: Attribute table of Banks

¢ Go to Editor save the edits and stop editing.

e Open attribute table of Flow paths feature class. You can see that left and right banks are
added in flow paths feature class as shown in Fig. 21.

Now label the flowpaths by using the Assign LineType . m button




Click on the : : button (notice the
change in cursor), G Aswizn Flowpath Type [g[ and then click on
one of the flow s 0 v paths (left or right,
looking downstream), and
name the flow J%’i‘;gt’"e' \ path accordingly as
shown in Fig 49 0K | | FTeRe . ]

Figure No 21: Define Channel

[ Attributes of Flowpaths : = =N
Shape * OBJECTID * Shape_Length LineType
¥ | Palyline 1 10625 444188 | Channel
Palyline 2 10673.43919 | Right
Palyline 3 10677.326646 | Left

Recordrﬂj 1 .Lli! Show:| All - Selected RecordsL!

Figure No 22: Flow path attribute table

Label all flow paths, and confirm this by opening the attribute table of the Flowpaths feature
class. The Line Type field must have data for each row if all flowpaths are labeled as shown
below in Fig. 22

h) Creating Cross-sections

Cross-sections are one of the key inputs to HEC-RAS. Cross-section cutlines are used to
extract the elevation data from the terrain to create a ground profile across channel flow.
The intersection of cutlines with other RAS layers such as centerline and flow path lines
are used to compute HEC-RAS attributes such as bank stations (locations that separate
main channel from the floodplain), downstream reach lengths (distance between cross-
sections} and Manning’s n. Therefore, creating adequate number of cross-sections to produce
a good representation of channel bed and floodplain is critical. Certain guidelines must be
followed in  creating  cross-section  cutlines: (1)  they  are  digitized
perpendicular to the direction of flow; (2) must span over the entire flood extent to be

maodeled: and (3)_always digitized from left to right {looking downstream). Even though

it is not required, but it is a good practice to maintain a consistent spacing between cross-




sections. In this exercise, let’s use an approximate spacing of 1000 meters for all
cross-sections.

1. Clickon RAS Geometry >Create RAS Layers—> double click on XS Cut Lines.

Create Create XS Cut Lines window (Fig.23) will appear, accept the default names
(eg. XSCutLInes), and click OK.

a \ I
@ Create XS Cut Lines |A
Cross-sectional Cut Lines IxscutUneg
OK | Help ‘ Cancel | ‘

Figure Mo 23 Create X5 Cut Lines
Create XS Cut Lines acknowledge window (Fig.24) will appear. Click OK

~ —

Create XS Cut Lines

Cross-sectional Cut Lines layer created successfully!
Complete layer by digitizing features.

OK

Figure No 24: Create XS Cut Lines Successfull

2. To create cross-section cutlines in XSCutlines featmire class. Click on Construct X5 cutlines

button. g 3

3. Create cross section window (Fig. 25) will appear. Give interval {eg 1000) & width (eg 1000).
Click OK.

7\, Create Cross Sections

XS Cutlines |XscutLines

Stream Centerline |River
Interval W
Width [1000




Figure No 25: Create Cross Sections

it
o ®

= £ Layers
SRl XS Cutlines|

2 O cross_section_modify

Eexru Bl e@ 3y

= @ Flowpaths
= @ River3D

5] Banks
=] River
=} landsat_I8_29_05_2013.img
RGB
M Red: Band 4
@ Green: Band_3
W Blue: Band 2
E B srtm_dem_utm

|80 w2

Value
High: 2579

Low: 1037

Figure No 26: Cross Section window

Note: We have surveyed cross section, So we replace automatically creates cross section

with survey cross section line.
Click on Add

~
Mame

dem?2
info

|z

|| dem2.aux

@ dem2

[ ] dem2.vat.H110M4-C43.356.12124.sr.lock
sections_UKashi_modify

mf' ¥_section

x_section

@ x¥_section

x-section-manual

Date modified

08/27/2018 04:47 ...
08/27/2018 04:47 ...
08/27/201803:24 ..,
08/27/2018 03:13 ...
08/27/2018 08:45 ...
09/19/2016 03:57 ...
08/27/2018 08:45 ...
08/27/2018 03:24 ...
08/27/2018 03:24 ...
08/27/2018 09:01 ...

Type

File folder
File folder
XML Document

ERDAS IMAGIME D...

LOCK File

Microsoft Excel W...
Microsoft Access ...
Microsoft Access ...
ArcGIS ArcMap D...
Microsoft Word D...

Figure No 27: Modify cross section

2 Cross_section_modify.shp will be added in Layer.

Go to Editor - Start editing. Select XSCutLines in Target.

Right click on XSCutLines file and open attribute table.

Select all the attributes and right click and select Delete Selected (Fig. 28). It will delete the

Size

button. Go to working directory and select cross_section_maodify.shp file

1KB
37KB

0 KB

34 KB

0 KB
1,972 KB
600 KB
2,819 KB



entire cross lines.
Go to Editor = Save Edits.
Close the attribute table

[ Attributes of

Shape * OBJECTID * Shape Length HydrolD Station River | Reach
Polyline 1 999999938 7 | <Null> <Null> | <Null>
Polyline 2 999.99999 8 | <Null> <Null> <Null>
Polyline A 999 999961 9 | <Null> <Null> | <Null>
Polyline 4 999.999568 10 | <Null> <Null> | <Null>
Polyline 5 1000.000026 11 | <Null> <Null> | <Null>
Polyline 6 999.999982 12 | <Null> <Null> | <Null>
Polyline ki 999.999983 13 | <Null> <Null> | <Null>
Polyline [ 1000.000063 14 | <Null> <Null> | <Null>
Polyline 9 999.999938 15 | <Null> <Mull> | <Null>
£ Ll in 1000.000055 16 | <Null> <Null> | <Null>

1L = Hash

Zoom To

Pan To
Identify...
Select/Unselect

Clear Selected
Copy Selected

Delete Selected | = e il e

@

Ly

i}

& Zoom To Selected
a

B

x|

Figure No 28: Delete XS Cut Lines

Now Right click on Cross_section_modify.shp file and open attribute table. In attribute table

select all the cross sections. Click copy button, then click on paste E button. It
will paste all the cross section of Cross_section_modify.shp file into XSCutLines file.

To verify this, open the attribute table of XSCutLines file as shown in Fig. 29

B 5%

. Shape* | OBJECTID * Shape_Length HydrolD Station River | Reach | LeftBank
| ¥ | Polyline 11 241.033229 17 | <Null> <Mull> | <Null> | <Null>
Paolyline 12 298 138374 18 | <Null= <Null> <Null> | <Null>
Polyline 43 239193768 19 | =Null> <Mull> =Null> <Null>
Palyline 14 352.592792 20 | <Null> <Mull> | <Null> | <Null>
Paolyline 15 285 462378 21| <Null> <Mull> <Null> | <Null>
Polyline 18 556 871811 22 | <Null> =MNull> <Null> | <Null>
i Palyline 17 459.651932 23 | <Null> <Mull> [ <Null> | <Null>
il Polyline 18 649 584349 24 | <Null=> <Mull> <Null> <Null>
g [[_[ Pelyiine 19 331312731 25 | <Null> <MNull> | <Null> | <Null>

.

Wl « [ I

s 2]

|
Show: | All Selected Records (9 out of 9 Selected)




Figure No 29: Update X Section
Go to Editor—> Save Edits =2 Stop Edits

a) Add HEC-RAS attributes to these cutlines

We will add Reach/River name, station number along the centerline, bank stations and
downstream reach lengths. Since all these attributes are based on the intersection of cross-
sections with other layers, make sure each cross-section intersects with the centerline and

overbank flow paths to avoid error messages.
e Click on RAS Geometry—> XS Cut Line Attributes—=All.

RAS Geometry ~| RAS Mapping ~ ;¢ 8¢ || & < < £ ApUtilities~ Help~ = Drawing*@ﬁ )

Create RAS Layers 3
Layer Setup EF:C All Cross-Section Tools X
Stream Centerline Attributes  » SheamCenicHine River w
XS Cut Line Attributes 4 River/Reach Names T T 5
Manning's n Values 3 Stationing
Levees » Bank Stations Flowpaths Fowpaths ~
Ineffective Flow Areas 3 Downstream Reach Lengths XS Cutlines XSCutLines o
Blocked Obstructions > Elevations

i dem2
Bridges/Culverts 3 All A = i
Inline Structures 3 XS Cutlines Profiles ¥SCutlines3D
Lateral Structures 3
Storage Areas 4 oK Help el

Storage Area Connections 4
Export RAS Data

Terrain Tiles 3

Utilities >

Figure No 30:XS Cut lines

After click ok

° After this process is finished, open the attribute table of XSCutLines3D feature class
and see that the shape of this feature class is now PolylineZ (Fig. 67).

= £ Layers
EWCl «SCutl ines3D) P Shape OBJECTID * Shape Length | XS2DID | HydrolD Station River | Reach | LeRE
— » [Polyline Z 1] 649 £84349 24 26 |_2414.9004 | river each | 06

= O cross_section_modify

=] XSCutlines

= Flowpaths

a River3D

=] Banks

= Record: 14 « PRy [ Show: [ Al Selected Records (0 out of I Selected opt
5 River e COri _]J —J—I DWW electes ECOr S( out of alel e) ptions




Figure no 31: XS Cut line 3D

Note: final and most important step before proceeding further is the
manually check the following feature classes:

River: Open the attribute table of River, and make sure all the attributes

data check, we will

i'ﬁ;ﬁ\-S'Géome“fry » RAS Mapping + <

Create RAS Layers b
are correctly
populated. Check the connectivity of the centerlines and make Layer Setup
sure there are no negative or invalid numbers for any fields. St Conterline Atthbutes. b
Flowpaths: Open the attribute table for Flowpath, and make sure that XS Cut Line Attributes 4
that the Line Type field is populated and that the line types are correct. S — >
For example, left should represent the left flowpath and Right should
represent the right flowpath for each reach. EGVRES 4
XSCutlines: Open the attribute table for XSCutline, and make sure that Ineffective Flow Areas 4
all the attributes are populated. Make sure that all numbers are positive Blocked Obstructions b
for StationNo, RLenth, L.Length and ChLength fields. If any number Bridges/Culverts >
for RLength or LLength is negative for any cross section, that cross- — R
section was most likely digitized in the wrong direction. Go back and ine Stctres
flip that cross-section, and re-assign the attributes. Do this for all cross- LRRIAAS MR 4
sections that have negative numbers for RLength or Length. Storage Areas b
Storage Area Connections [ 4
After verifying all layers and tables, click on RAS Geometry—> Export E—— >
i s ermain 1es
RAS data (Fig. 31). Confirm the location and the name of the export
file (GIS2RAS in this case), and click OK. During the export, you will Utilities 4
see a series of messages as shown in Fig. 31.
g Export RAS Data
RAS File |DAMNHEC training™cross section\GISZRAS | EE
Messages
Start Time _I';_ﬂjjs:age Message e
| ) e SO o i o
02:32:21 |iotarmatne | B o heen crnade
02-32-71 | Export GIS Data >
02-32:21 |
"02_.32:21 | SIS data for RAS exported successtully!
[02:32:21 | sfully exported
02:32:21 | _training\cross_section\GIS2.._ |
02-32:271 | OTTTiS S Created St W Iraringhcross_sectionGIS2ZRAS xml
23222 [informative | RAS SDF crested at: DHEC_training\oross_section\GIS2RAS.... |
02-32:22 Informative | GIS data for RAS exporied successiully
* |




I

Figure No 31: Export RAS data

After the export is complete, close the window. This process will create two files:
GISZRAS Xml
GIS2RAS . RASImport.sdf.

mport these data into a HEC-RAS model.

Importing Geometry data into HEC-RAS

1.

Open HEC-RAS software (Fig. 32).

BS HEC-RAS 5.0.3
File Edit Run View Options GISTools Help

m’:|EI| i(it|£|£‘| w|—i

P P e e e s A P ] el

Project:

*
Jik

Plan:

Geometry:

Unsteady Flow:

|
|
|
Steady Flow: |
|
I

Description :

_l [Us Customary Units

Fig. 32

2. GotoHEC-RAS 5.0.3 = Options— Unit System (US Customary/SI)... (Fig. 52)

B HEC-RAS5.03 = X

File Edit Run View  Options G5Tools Help

@@ Ygs[m]  Progemsew > Pzl 2| BB o Kol

Default Parameters »

Project: | .Un"lt [US - ’{Sn l'i"
: system Gﬂm‘lﬁ!}? e

Plan: I . . 2 :

Geometry: I_ Convert Project Units ...

Steady Flow; |_ Convert Horizontal Coordinate Systems ...

Unsteady Flow: | |

Description : |

_! IUS Customary Units

3

Fig. 52

. HEC-RAS window (Fig. 53) will appear.
Select System International (Metric System).
Click Ok.

RAS acknowledge window will appear.
Click Yes.

HEC-RAS

Select Units System

" 1S Customary
&+ Bystem International (Metric System)
™ Setas default for new projects

oK ] Cancel |

Help

Fig. 53




5. Save the new project by going to File—> Save Project As. Select working directory and
save as Ukashi.prj as shown in fig. Fig. 54. Click OK

Save Project As

Title

File Name

|Ukashi

|=r]

Selected Folder Default Project Folder

Documents

d:\

PROJCS[WGS_1984_UTM_zone_44N", GEOGCS[G

oK Cancel Help

po.prj

Create Folder ... |

Ed:\

[0 AP_Classification
[[JBeas Data

(L3 cfrbadwp-MPYICZIE
B8 HECRAS

(A New falder

[ New folder (2)
[E20ld Work

ka1

[ Python

A Rrajat

(LA Rajat LULC VIC trials
[CARajat_vIC_1km

(A rough
Droutﬂep

D route_1.0

| E0d: [acer DaTA]

Eﬂect drive and path and enter new project name.

Fig. 54

6. To import the GIS data mto HEC-RAS, Click on View/Edit Geometric Data
Geometric Data window (Fig. 55) will appear.



W Geometric Data - (i) X

File Edit Options View Tables Tools GISTools Help
Tools  River 2D low At20Areal 2nfrea | 20 ey RE Description : Flot WS extents for Profile:
Conn ines (Breaklines pg, d Station
G | [ unﬁ P | <12 & || =l =]

Reach
Editors i

Junct J
=

Eos_s
Section

Storage EAME0AMEE| A2 Ared
Fres

Puimg

Brdg,Cul

Inline
Structure

Lateral
Structure

|

Storage
Frea

20 Flaw
Hrea

Fal2DArea
Conn

Bia|

Fump
Station

HTah
Pararn.

“Wigy
Picture

a.l J_l

I 0.5930, 0.25604

Fig. 55

7. Click on File=>Import Geometry Data—> GIS Format (Fig. 56).



File Edit Options View Tables Tools

SA20 Area

New Geometry Data
Open Geometry Data
Save Geometry Data
Save Geometry Data As ...
Rename Geometry Title
Delete Geometry Data

Copy to Clipboard
Print ...

Exit Geometry Data Editor

==

Storage
Area

20Flow
Area

2420 Area
Conn

B0

Import #GIS Format data file (Fig. 57) will

5 o

GIS Tools Help

20Anea
Brealr.Llne-i ;ﬁ‘

BC Lines

s”t‘;%“”
ion
.EH

GIS Format ...

USACE Survey Data Format ...

HEC-RAS Format ...
HEC-2 Format ...

UNET Geometry Format ...

HEC Stream Alignment ...
Mike 11 Cross Sections ...

CSV (Cemma Seperated Value) Format ...

GML Format ...

Fig. 56

appear. Browse to

GIS2RAS.RASImport.sdf file created in GIS, and click OK.

Import #GI5 Format data file

Title

File Name

= zdf;*.geo D:\HECRAS

Selected Folder

DefaltProject Folder | Documents |

#This file is generated by HEC-GeoRAS Be

0K Cancel Help

GIS2RAS . RASImport.sdf

[E3 2imay

|<;_?|D:\

[ Hec_Ras_data_AFG

Create Folder ... | [=d: (acer DATA] |

Belect GIS Format file to import

Fig. 57




9. Import Geometry Data window (Fig. 58) will appear. In the Intro tab, select SI
(metric) Units for Import data as and click Next.

== ~
Import Geometry Data . F
- T

Intro | River Reach Stream Ijr:m| Cross Sections and 1B Nodes | Storaqe Areas/2D Flow Areas and Coﬂnecﬁon5|

The import data has been read into a temporary geometry structure and
now can be incorporated into the current geometry file. Step through the
various tabs to select the desired import options. When all the

appropriate options have been set, press the Finished - Import Data
button.

Current RAS project units: | US Customary Units

Import data as: " US Customary units
@ ST {metric) units

Import data wil be converted from SI to US Customary on import.

Frewous:l Next | Finished - Import Data | Cancel |

Fig. 58

10. Confirm the River/Reach data, make sure Import stream lines box is checked, and click
Next as shown in Fig. 59.

Import Geometry Data

Intro River Reach Stream Lines | Cross Sections and IB Nodes | Storace Areas/2D Flow Areas and Connections |

to import, and modify the import name and

Merge Mode

Import |Import
|Status |Stream Lines |
new [ | Replace

Previous

Finished -ImportData | Cancel



Fig. 59

11. Confirm cross-sections data; make sure all Import Data boxes are checked for cross-sections
(Fig. 60), and click Finished- Import Data (accept default values for matching tolerance,
round places, efc).

Import Geometry Data

Intro | River Reach Stream Lines  Cross Sections and I8 Nodes | Starage Areas/20 Flow Aress and Comnections |
Node Types in Table ‘

|V Cross Sections (XS) [V Bridges and Culverts (BR/Culv) W Iniine Structures (IS) W Lateral Structures (LS)

Import River:  |(All Rivers) ~ | Import As: #RS=9 #New=5 #Import=9
Import Reach: v | Import As: CheckNew | CheckExisting | Reset |
e tab

RAMAAIATR

~Match Import File RS to Existing Geometry RS

F Matching Tolerance  [[@1 Matdmmnng|
™ x Round Selected RS
It ’VZder:i'na&r.iacs - Round ‘
¥ Station Elevation Data mr —J
¥ Reach Lengths I sl -Generate RS Based on main channe! lengths
™ Marining's 1 Values i {only available when looking at a single reach)
[¥ Bank Stations r Starting RS Value: [0 2 decimal place_~
I'r: "'_""”"F parsioh Coefl | I P Create RS inkiometers | Create 8S in meters |

E: test | Finished-importpata | cancel |
o 60

12. The data will then be imported to the HEC-RAS geometric editor as shown in Fig.
61.

“¢_ Geometric Data — [m] b4
File Edit Options View Tables Tools GISTools Help

Tools  River Storage | 20Flew |sareperealsarepprea) zoarea | 2pag
Reach Area Area Cown EC Lines |Breaklineg n,
s, = | G | S | AEED| Fegions

Description : Plot W5 extents for Profile:

I ~ el =

Pump
Station

o

RS
S| B

Inline
Structure.

Lateral
Structure:

i

Storage
iy

20Flow
Area

EAI2DArea)
o
BiE
Pump %5818.605

Station

B

HTab
Paramn.

Wiewy
Pirture

255208.75, 3403017.85




Fig. 61

13. Save the geometry file by clicking File—> Save Geometry Data as Ukashi. Click OK.

14. Next, click on the Geometry editor and select Edit and /or create cross-sections [ froes

tool. i JSection
15. You should see the cross-section window as shown in Fig. 62.
== Cross Section Data - Ukashi = O x
Exit Edit Options Plot Help
River: = foply Data I\,ﬂ:{; +‘| PlotOptions [~ KeepPrev XSPlots Clear Prev | ¥ Plot Terrain (f availa
Reach: IReach _VJ River 513.:'12442.?2 lj_l'_!_l Ukashi Plan-
Description I _|
Del Row | Ins Row I Downstream Reach Lengths 11851 L d
e egen
Cross Section Coordinates I LOB Channel ROB —e
Station Elevation o !515.42 516.08 517.2 Ground
] [
1o 118166 b Bank Sta
_ 2|26.78 |1179.11
3|53.5 |1173.22 T 4475]
_ 4|80.34 |1167.4 £
58058 |1167.38 iRt R §
~ 6|107.13 1164.58 Left Bank I Right Bank u!; 11701
~7|1.22 1163.83 BO.58 |128.22
_8[133.91 |1163.63 o3 2|
_ 9| 160.69 |1164.59 Conftraction Expansion ]
10 187.47 | 1170. 18 01 .3
11]214.25 A7 || i
ki kv wi i i o 50 100 150 200 250
Station {m})
[select river for cross section editing
Fig. 62

Note: Each cross-section in HEC-RAS has the following information:

Location: This is described by using three pieces of information: River, Reach and River
Station.

Elevation Profile: This is the profile view that you see on the right hand side in the cross-
section window. This profile is created by using the information from the station and
elevation columns in the Cross Section Coordinates table on the left. The numbers in the
station column shows the distance along the cross-section from left to right (looking




downstream along the flow direction), and the elevation column shows the elevation at
each station point. You can think of Station and Elevation as the (x,z) attributes for the
cross-section line. Each station/elevation point is represented by a black dot on the cross-
section profile.

Bank locations: These are represented by two red dots on the cross-section profile. The
location of these red dots is dictated by the station numbers for Left and Right Banks in
the “Main Channel Bank Stations™ table in the cross-section window.

Roughness (Manning’s n Values): The horizontal line at the top of the cross-section profile
shows the distribution of Manning’n value along the cross-section. This distribution is
defined in the n Val column in the Cross Section Coordinates table. You will see that the n
Val column is not populated for each row. The wvalues are only reported
at stations points where there is a change in the Manning’s n.

Distance to the next downstream cross-section: This information is presented in the
Downstream Reach Lengths table. The numbers for LOB, ROB and Channel represent the
distances to the next downstream cross-section along the left over bank, right over bank and
channel, respectively. These distances are computed by using the flow path features that are
digitized in HEC-GeoRAS.

Note: As we have the surveyed value of elevations on cross section lines, so we replace the
Station value and corresponding elevation value.



16. Go to working directory open sections_UKashi.xlIs file (Fig. 63) which consist the value
of distance (location) along with elevation values for each cross section lines.

(=
Home | Insert Pagelayout  Formulas  Data Acrobat

Fhpsics arial B 5 Number I gzo = i [

B Dacony |& fé ﬁ Normal 7 Normal Bad =) =: ﬂ:‘ &
pafte e aotor | B 'H e i A" B Merge &Center ~ | [ § - % » H'-ﬁg ) Fcul;:nzfunnﬂga‘v Fir;:fs Good Neutral = lns'en DEEE& Fnrfnat O \iaer

Clipboard & Fort 2} Alignment = Number & Siyles Cells
830 ~ @ £| 11735

" Y S Y—— T —( F—— H T— — K L M N[ 0 P Q

1 |Cross 1 Cross 2 Cross 3 Cross 4 Cross § Cross 6 Cross 7 Cross 8

2 Di (m]EI ion (m))i (mil i i (mi i i (m EI ion (m) i ( i ( ion (stance ( ion (stance ( ion (stance (
4l 0 1174.365 0.00 1196.539 0 1154.74 0.00 1189.893 0 1136795 000 114456 0 112376 0 110925 0.00
4 20 1169.235 10.00 1195.451 5 1152.62 10.00 1188.944 1 1134295 10.00 1140.75 2 112311 12 1099.35 10.00
| 40 1164.000 20.00 1183.671 11 1152.195 20.00 1182.231 4 113427 20.00 1136.09 9 112226 13 1098.25 20.00
6 55 1164.000 30.00 1183.639 18 1147 615 30.00 1180.871 5 1131835 30.00 1130.26 12| 1119.75 17 1098.1 30.00
7| 60 1158.350 40.00 1178.165 33 1147 465 40.00 1174.400 11 1131735 4000 112454 27 11194 18 1093.75 40.00
8 75 1158.110 50.00 1174.390 40 1145.68 50.00 1169.335 12 1129.515  50.00 1120.71 37 1118.03 32 1092.37 50.00
g 80 1157.650 60.00 1172603 60 1140.965 60.00 1163.078 14 1129.54  60.00 112034 47 111827 39 10924 6000
10 90 1157.980 70.00 1170.221 70 1140.06 70.00 1156.596 24 112845 7000 1120.05 57 11182 40 1088.93 70.00
1" 95 1158.340 80.00 1168.348 80 1139.74 80.00 1149.828 34 1128.79  80.00 1119.82 67 111853 52 1088.8 80.00
12 99 1158.910 90.00 1164.802 90 1139.375 90.00 1143115 44 1129385 90.00 111973 77 111891 63 1088.57 90.00
13 105 1159.080 100.00 1160.000 100 1139.175 100.00 1140.808 52 1129.055 100.00 1119.42 a7 1119 77 108462 100.00
14 107 1160.830 101.97 1158.422 110 1138675  107.37 1139.946 56 1128515 107.17 1119.14 97 1119.28 79 1083.15 110.00
15 110 1161.000 110.00 1154.174 120 1138.845  110.00 1135.847 60 112875 110.00 1119.03 107 1119.24 82 108245 120.00
16 120 1161.040 120.00 1151.847 130 1139.075 120.00 1134.291 62 1123755 120.00 1116.09 117 1119.49 92 108129 130.00
17 130 1160.770 123.16 1149.886 140 1140.025 130.00 1134.462 67 1123455 130.00 1113.76 127 111961 102 1081.25 140.00
13‘ 140 1159.960 130.00 1149.634 150 1139.535  140.00 1134.147 74 1122595 130.30 1113.71 137 1119.95 112 1080.58 150.00
19 145 1166.855 139.49 1149.886 155 1139.975 150.00 1133.865 84 1122305 140.00 111346 147 112028 120 108024 160.00
20 150 1167.430 140.00 1149.869 160 1140.06 155.70 1133.866 94 1121885 150.00 111274 157 1121.06 132 1079.59 170.00
21 161 1167.250 150.00 1153.114 170 114011 160.00 1133.687 104 1122185 160.00 1112.76 167 112153 142 1079.28 180.00
22 168 1164.155 159.28 1153.42 180 1140.265  170.00 1133.411 114 1122335 170.00 1113.56 177 1120.48 152 1079.56 190.00
23 179 1164 455 160.00 1153.401 190 1140685 180.00 1132.852 124 1122515 171.49 111371 187 112087 159 1080.04 200.00
24 180  1168.185 170.00 1153.128 193 1145685  190.00 1132.886 129 1123365 180.00 11148 192 112068 167 108277 210.00
25 190 1168.510 173.32 1153.42 200 114764  200.00 1133.637 139 1123.805 190.00 11134 194 111651 170 1089.67 220.00
26 195 1172.685 180.00 1154.128 210 1148.775  210.00 1133.198 149 112325 200.00 1114.24 197 1116.54 176 1085.51 230.00
27 200 1172.835 190.00 1155.197 215 1153.205 220.00 1133.798 156 1123.83 210.00 1117.26 207 1114.83 182 1095.87 240.00
28 210 1173.020 192.60 1158.422 220 1154.12 230.00 1133.082 159 1124565 21540 1119.14 210 1115.53 193 1096.38 250.00
29 220 1173.375 200.00 1158.572 225 1157.77 23423 1133.866 169 1125 220.00 112048 211 110754 206 1097.02 260.00
30 230 1173.500 210.00 1158.824 230 1158.445  240.00 1135.084 179 1124575 230.00 1122.05 217 1107.12 220 1097.22 270.00
31 220.00 1160.53 235 1158.31 24922 1139.946 189 112469 240.00 1122 26 227 110738 233 10979 280.00
32 230.00 1161.795 240 1158.305  250.00 1140.155 199 1124445 25000 112249 237 1107.67 241 1099.16 290.00
33 240.00 1165.392 260.00 1142.355 209 112369 260.00 112277 247 1107.84 248 1099.76 300.00
34 250.00 1170.674 270.00 1143.167 219 1124 54 270.00 1123.04 257 110832 252 110162 310.00
35 260.00 1176.706 280.00 1143 241 220 112878 280.00 1123 32 267 110862 256 110078 320.00

Fig. 63

-

== Cross Section Data - uttarkashi_geometric_data

17. Copy Distance (location) and elevation Uo:ﬁ‘E’“f O — e
" p ndo Editin ) 4 Plot Optior
of each cross section lines from excel | s ' Arji'
" 5 Cut Ctrl+X 10101.28 v 32
file and go to HEC-RAS’s Cross Rea“j e I —I:I]
% & % Desci =| s
Section data window. Click on cross Q\ Paste  CrilsV
. . i ) Downstream Reach Lengths 121
section coordinate sub window. It will |/gmm  copyPiotToClipboard 08 | Chamnel | ROB
select all station and elevation values. Delete .. T T 120
2 Insert ...
1 0B Channel ROB 119
1171.05 I | I E
1163.24 - - B
18. Go to edit and click on Paste (Fig. 64). 5|104.86 1161.98 =
i ' ; 6/119.26 1160.81 =
It will replace automatic geometric data 71149.07 Tieas [104.86 [200.15 e
8|178.88 1159.08 Cont\Exp Coefficient (Steady ||
9|200.15 1164.83 Contraction Expansion 116
1167.14 o1 03
11|238.51 1178.72 J 115
|Edit Station Elevation Data (m)




value with sarvey geometric data,

Fig. &4
1%, In Manning s n Values option assign 0.04 for LOE, Channel and ROB.

20, In main Channel bank Stations option, replace the value of Left Bank and Right Bank by

the nearest values using data in excel file eg. First cross section replaces 44.28 by 40 and
17679 by 179,

21. Click on ilarrowtool for going to next cross section,

22, Cut Line Extension Option window will (Fig. 85) appear. Click on Aeccept edits and
adjust cut line option,

- T ————

Cut Line Extension Options -e

The cross section has GIS cut lines specified, and the starting or ending station has been changed.
The cut line wil no longer have the same length as the cross section. Which of the following do
you want to do?

Accept edits and leave cut line alone Accept edits and adjust cut line

Fig. 65

23, Now window for next croze section elevation will come, Apply similar stepas for others cross



section.
24 Close Cross Section Data window,

25, Go to Geometric Data window - File. Click on Save Geometric Data. Close Geometrie
Diata window,



EXERCISE 5:

HYDROLOGICAL MODELLING USING HEC-HMS

Rainfall Runoff Analysis through given input data (see in table no 1)

S Item (content Type) Value

no

1 Area of Basin 1 4285 gq km

2 Loss Method SCS Curve Number

3 Transform Method SCS Unit Hydrograph
4 Base flow Method None

3 Curve Number 75

6 Impervious (%) 0.0

7 Graph Type Standard (PRF484)

8 Log Time 00:00

9 Precipitation Time 01 Jan 1979 to 31 Aug 2017
10 | Data Source Manually Entry

11 | Unt Incremental Millimetre
12 | Time Interval 1 Day

Table No 1: Input Data

1. Step by step procedure for Creating a Single Basin HEC-HMS Model

Open HEC-HMS software from file menu
Click on start and select HEC-HMS
Automatically HEC-HMS window open (see in fig no 1)

Watershed Explorer

Component Editor

= [

A g

mEER EEEE 3 9

Desktop

Messsage Log

Figure No 1: HEC-HMS Window




2. Description of T ool

= Mame Image Dezcrption

o,

1 HMew M Create a Mew Project

& Chpen = Cipen A project

3 save Save A Project

4 Print = Print current selection

3 Arrow Tool & Ohiect selection

& Pan Tool 3 Moving Object (Manually)
oL Zoom tool aQ MMagnifier

B sub basin G . sub basin creation tool
g Eeach 1o i Eeach creation Tool

10 Eeservoir ™ Eeservoir Creation tool
11 Tunction & : Junction creation tool
12 Diwersion 2o " Diwersion Creation Tool
1% Point source T . source Creation tool

14 Catlet .*L_;_t, m sink creation tool

3. Create a New Project (demol): On the main Menu, click on File==MNew. First specify the
location of where vou want to save your project, give a name (demoll), accept the default unit
system (Metnc), and click on Create. Mote that the unit system may be different for different
projects (see in fig no 23

=tepl: Click on File and select new {Crel+IT)

stepe: Write project Mame {demol)
sStep 30 Description of project

Table No 2: Description of Tool Bar

stepd. 1o Browse projectlocation (HEC-HWE for single basin
stepd. 20 Select directory where save the project (DA kackms)

atepd: Click on Create

After that automatically demol project show in HEC-HME window




o

Figure No 2: Create new project

File Edit View Components Parameters Compute Results Tools Help

D=2 & ko SR I I N e e

oemol

—None Selected—

Components Compute Results

Project

Name: demol
Description: |HEC-HMS for single basin

Output DSS File: |D:Yhechms'\demo 1\demo1.dss

NOTE 10008: Begin opening project "demo1” in directory "D:Yhechms'\demo1” at time 124092018, 15:15:15.
NOTE 10019: Finished opening project "demo1” in directory "D:\hechms\demo 1™ at time 12Aug2018, 15:15:16,

Figure No 3: Show the demol file in black box

4. Create Basin Model: A basin model represents the physical description of the watershed in a
HEC-HMS project. First an empty basin model is created, and then it is populated with all the
necessary information needed to create the complete description of a watershed. In addition to
including the physical description, a basin model also includes information on the mathematical
methods (or equations) that will be used in simulating the hydrology of the basin, and the values
for all the variables in those equations. The variables in all the equations are called parameters
becanse by changing the values for these parameters we can change the output from the model.

See in fig no 4

Stepl: Click on Component and select Basin Model Manager
Step2: Click on New

Step3: Give name of basin (Basinl) than click on create

After that close A the window




B HEC-HMS 4.2.1 [D\hechms\demoTidemo.hms]

File Edit View Components Parameters Compute Results Tools Help

DB v asswsFeiE

= Basin Models
- 7 Basin 1

Components Compute | Results

—Hone Selected— ~% B HE .

4] Basin Model [Basin 1]

Current basin models

Project

Name: demol
Description: |HEC-HMS for single basin
Qutput 0SS File: |D:\hechms\demo1idemol.dss

‘ New
| I Refiame. .
B Create A New Basin Model X
= Name :| Basin 1
= Description :| dema for single basin mode] B
Cancel
T
<

NOTE 10008: Begin opening project "demo1”in directory "D:thechms)demo1” at time 12Aug2018, 15:15:15,
NOTE 10019: Finished opening project "demo1” in directory "D:\hechms|demo1” at fime 12Aug2018, 15:15:16.

Figure No 4: Create a new Basin Model

5. Create sub-basin: This is done by using the create sub-basin tool (E* ). Select the sub-basin tool,
and click on the basin model (white window in the desktop pane). You will be prompted to enter
the name and description of the new sub-basin as shown below.

B HEC-HMS 4.2.1 [D:\hechms\demo1\demol.hms]

File Edit View Components Parameters Compute Results Tools Help

DB S |k ¢ qé

demal
Basin Models

Components Compute Results

e ) P &» P bt [ione Selected— ~Hone Selectsd— SEE B B K]

) Basin Model

Hame: Basin 1

Desaription: demo1 for single basin model -E

Grid Cell File: =
Local Flow: [ No ~
Flow Raties: No -
Replace Missing:  No ~
Uinit System:  Metric v
Sedment: No ~
Water Quality: No ~

£+ Basin Model [Basin 1]

B Create A New Subbasin Element X
Name : Subbasin-1
Desaription : dema 1 for single basin| B

Create Cancel

<

NOTE 10008: Begin opening project “"demo 1™ in directory "D:\hachms\demo1” at time 12Aug2018, 15:15:15.
NOTE 10019: Finished opening project "demo1” in directory "D: \hechms'\demo 17 at time 124ug2018, 15:15: 16.

Figure No 5: Create sub-basin

Click Create. You will see that vour basin model now has a sub-basin and all the information related
to this sub-basin can be entered in the component editor. A sub-basin is just one of the components

of your basin model.

Expand Basin 1 and Sub-basin 1 in the watershed explorer, and vou will see the following (or a

variation of it).



G,
step 1 SBimple click on sub basin = after that click on window

otep 20 Type name of Sub basin (Subbasin-1) click create than close s sub basin window

Thiz information can be edited by using the component editor, and each label above 15 related to a
“method” in the basin model. You can think of a method as a hydrologic process, and then you have
to choose which equation ¥ou want to use to stmulate this hydrologic process. The Canopy method
all owrs users to model the interception and evapotranspiration in the watershed. For this demo, we
will ignore this method. The surface method allows users to represent depression storage in the
watershed Again, we will ignore surface method for this lab. The next method allows users to
represent losses in the ramnfall. We know that not all rainfall becomes runoff because some of it is
lost to infiltration. The loss method lets users to model this infiltration by using various equations.
We have not covered this topic in the class yet, but for completing this lab, just change the loss
methodto 2C3 Curve Number for now by using the component editor. The transform method all owes
uszers to convertthe rainfall {after subtracting l osses) to streamflow hydrograph. Change the transform
method to 5CS Unit Hydrograph, Base flow method allows users to account for existing flow
conditions in the outlet stream. Again, we will iznore base flow for this lab.

Finally, enter the area of the watershed (4285 km?2) in the area box of the component editor. If you
see mput for latitude, longitude, etc., simply ignore those for now. The exact placement of this sub-
basin is not important for this demonstration.

Components Compute  Results Subbasin-1 b4

s Subbasin Loss Transform Options - . You are about to change methods and lose

= all current loss data for this subbasin, Are
Basin Name: Basin 1

e R e Lt you sure you want to change methods?

Description: |demo 1 for single basin =] 9 Mo
Downstream: | —Mone— [l
“Area (KMZ) |4285 I Subbasin-1 >

Lo Deglre s You are about to change methods and lose

Latitude Minutes: Wault all current transform data for this subbasin, Are
Latitude Seconds: you sure you want to change methods?
Longitude Degrees: 3.2 No
Longitude Minutes:
Longitude Seconds: Subbasin-1 3
Canopy Method: | -Mone— o
Surface Method: [—None— y f You are about to change methods and lose

s all current baseflow data for this subbasin, Are
Loss Method: | SCS Curve Mumber

Transform Method: | SCS Unit Hydrograph |
Baseflow Method: | -—-Mone--

)

you sure you want to change methods?

7 4.2

=
)

[:h

Figure No &: Basin Description

By specifving names for each method, we are basically telling the program which equation to use.

To execute these equations, we need to also specify values for all the variables (parameters) needed,



The values for these parameters are provided in the additional tabs that you see in the component
editor for each method. Because we only chose two methods (Loss and Transtorm), you will see that
there 15 a tab for each method in the component editer. Click on the Loss tab, and enter a value of
zero for initial abstraction, 75 for curve number and zero for tmpervious cover. We will learn about
these variables later in the semester. In the transform tab, enter a value of 60 mm for lag time

C t= Compute Results
ompaonen Components Compute  Results

g 2 :
S4 Subbasin LSS Transform Options
e 1S Subbasin  Loss Transform  Qpfions

Basin Name: Basin 1
Element Name: Subbasin-1

Initial Abztraction (MM)

Basin Name: Basin 1
Element Name: Subbasin-1

Graph Type: | Standard (PRF 434) e

Curve Number: | 75| *L.ag Time (MIN) |00:00]

*Impervious (%) (0.0

Figure No 7: Basin Loss & Transform Information

Do not input any information for options. Select* None” for Canopy, Surface and Base tlow methods.
Save your project You have now entered all the necessary mformation needed to represent a
watershed in the basin model.

Fobacktowindowsexplorer, and open the Basinl basin file innotepad to seehow all the nformation
in the basin model 15 stored in a simple text file Now that we have a basin model, we need some
iput to drive the simmlation. The primary driver of a hydrologic event 15 precipitation. Mote that
precipitationframntall are typically recorded using weather stations or rainfall gauges. So to provide
rainfall input, we first have to create a precipitation gage.

6. Create a Precipitation Gage station: To create a precipitation gage, go to Components

Editor=>Time Series Data Manager. Select Data Types as precipitation gages, and click on New,
Usze the default name and provide some basic description for the gage. Click Create,
In the watershed explorer, you will see that a new folder called Time Series 15 created. Expand
this folder to see ancther folder called Precipitation Gages, and then gagel 15 created mside the
Frecipitation Grages folder. We will populate this gage with the information presented in the table
below. What we have here 15 daily rainfall data n mm from Jan 01, 1979 to 31 August 2017 Note
that this information 1s hypotheticall

Stepl: Click on component

StepZ: select time series data manager
Step3: Click on new

Stepd: Type gage name and description




& HEC- 4.2.1 [D\hechms\demoT\demol.hms]
File Edi Components Parameters Compute Results Tools Help
| B L s
O = i@ Basin Model Manager u \%» < r:t.l —Hgnssaeded_—

% B E H .

—None Selected—

Meteorologic Model Manager ) Basin Model [Basin 1]

demol i
: Control Specifications Manager

Time-Series Data Manager I
Paired Data Manager
Grid Data Manager

B | Byt 3
'j@%
B |z

B

Components Compute  Results

1% Subbasin Loss Transform Options

Basin Name: Basin 1
Element Name: Subbasin-1

Cescription: |demo1 for dnﬁle basin

iy m

Downstream: | —Nans—
*Area (KMZ) 4285
Latitude Degrees: [

(oo P e

B Time-Series Data Manager X,

Data Type:  Precipitation Gages ~

Current time-series data

Copy.

New..,

& Create A New Precipitation Gage

a

Name ;| Gage 1

Description :| gage 1 for subbasin1 {demo1)|

=

Cancel

|

X

Figure No 8: Component Analysis

The gage that we just created has the input that we need, but the program does not know that this
gage is located in the sub-basin we have created. To link this precipitation to the sub-basin, we
need to create a meteorologic model. Before you proceed, check that the units for rainfall are

correct.

demo1l
=) Basin Models
= &4 Basin 1
124 Subbasin-1
= Time-Series Data
Precpitation Gages
- B Gage 1

8 (15=]011an 1979, 00:00 - 314ug2017, 00:00

=

Components Compute Results

Components Compute Results

[ Time-Series Gage  Time Window Table Graph

Gage Name: Gage 1
*Start Date (ddMMMYYYY) |P1Jan1979
*Start Time (HH:mm) |00:00
*End Date (ddMMMYYYY) 31Aug2017
*End Time (HH:mm) |00:00

Eé‘ﬁrne—Ser ies Gage Time Window Table Graph

Gage Name: Gage 1
Description: bagel for subbasin1 (demo 1)
Data Source: Manual Entry
Units: | Incremental Milimeters
Time Interval:

=

1Day
Components Compute Results

U%Tlme-Series Gage Time Window Table Graph

Time (ddMMMYYYY, HH:mm)
01Jan1979, 00:00
02Jan1979, 00:00
03Jan1979, 00:00
04Jan1979, 00:00
053Jan1979. 00:00

Precipitation (MM)

CIDOCII

Figure No 9: Gage 1 Data




= [k H = - =

m Home Share Wiew File Home Insert Page Layd

- i - e
— 1~ > This PC > ACERDATA (D:) > hechms T I Cut CoRER
e - ~ p E= Copy -
geclogicalmap MName aste = =
) = " Format Painter = r u
e
S ey Clipboard = F
lohani_sir deerol
rrkgsir ipeg B2 = I~
B gagel data
22 Dropbox e | £ JE—— L=
1 |Date Precipitation
@ OneDrive 2 o1/01/1979 o
2 01/02/1979 o
Bl This PC 4 O1/03/1979 o
8 3D Objects 5 01/04/1979 o
& 01/05/1979 o
_ Biesitam 7 01/06/1979 o
=] Documents 2 o1/07 /1979 o
B Downloads = 01/08/1979 o
Jrg - 10 | oisoo/io7o o
REShE 11 01/10/1979 o
= | Pictures 12 01/11/1979 o
B videos 13 01/12/1979 o
2o ACER (C 14| 01/13/1979 o
== £E=) 15| oisiasiozo 65026
— ACER DATA (D:) - 16 01/15/1979 0.19101
R 17| oi/isfioze 24167

Figure No 10: Data in Excel Sheet

7. Create new metrological model: A meteorclogic model or file contains meteorologic
information to drive the hydrologic simulation. You cannot run a HEC-HMS simulation without
a meteorologic model/file. To create a meteorologic model, go to Components>>Meterologic
Model Manager, and create New. Use the default name and provide some basis description and
click Create.
Stepl: Click on Component
Step2: Click on Metrologic Model Manager
Step3: Click on new
Stepd: Type Name and description

B HEC-HMS 4.2.1 [D:\hechmshdemol\demol.hms]

File Edi Components Parameters Compute Results Tools Help
(] | &8 Basin Model Manager e o2 b | None Selected- ~Mone Selected-- v B EES
- 23 i
- 7 Meteorologic Model Manager 72 Basin Model (Basin 1]

= Basin Mac Control Specifications Manager
| &8 Basin| liﬁ Time-Series Data Manager

i Trm:‘;e:: |2 Paired Data Manager
= Precip Hfl  Grid Data Manager

5] [ Gage 1 |

EEQ 0121979, 00:00 - 31Aug2017, 00:00

Current meteorologic models

Components  Compute  Results B Create A New Meteorologic Model

(B Time-Series Gage  Time Window Table  Graph Mame ;| Met 1

Time (ddMMMYYYY, HH:mm)  Precipitation (MM)

Description ¢ | meterologeal model for demo 1‘
011an 1979, 00:00 A
02Jan1979, 00:00 | 0

03Jan1979, 00:00 | ol

Figure No 11: Metrologic Model Manager

You will see a new folder called Meteorologic Models in the watershed explorer, and if you expand
this folder, you will see the Met 1 file that you just created. Under Met 1 label, you will see Specified
Hyetograph label. Click on Met 1 in the watershed explorer and then click on the Basins tab in the
Component editor, and then click Yes on Include sub-basins. This will link gage 1 to sub-basinl.



Next, select the specified hyetograph label in watershed explorer, and then select Gagel for sub-basin

1 n the component editor as shown below . #
demol demol
=~ | Basin Models =) Basin Models
-5 Basin 1 =45 Basin 1
1249 Subbasin-1 1 1&4 Subbasin-1
=~ Meteorologic Models = Meteorologic Models
R Rt 1] =35 Met 1
: A0 Specified Hyetograph o e)specified Hyetograph
=k _ Time-Series Data = Time-Series Data
= Precipitation Gages = Precipitation Gages
= Eﬁ Gage 1 E E% Gage 1
- [[f9 013an 1979, 00:00 - 31Aug2017, 00:00 --[f5 013an1979, 00:00 - 31Aug2017, 00:00 m
Components Compute Results Components Compute Results
2#» Meteorology Model  Basins  Options Specified Hyetograph
Met Name: Met 1 Met Name: Met 1
Basin Model Include Subbasins Subbasin Name Gage
Basin 1 Yes| Subbasin-1 Gage 1

Figure No 12: Specified Hydrograph

Next, select the Met 1 and then change the Replace Missing to “Set to Default” as shown below. The
earlier option (abort) will not let the model run if the simulation time is longer than the rainfall
duration.

Save your project. Now we have the watershed description and the input information. The next thing
18 to provide some basic information on the time-step to run the model and the duration because we
know that the rainfall occurred from 00:00 to 00:00.

8. Creating a Control Specification Model

Step 1: Click on Component

Step 2: Click on control Specification Manager

Step 3: Select new

Step 4. Create (Name: Control 1, Description: Control Specification for demol)
& HEC- .2.1 [D:vhechms\demeTlidemol.hms]
File Ed\@ Components Parameters Compute Results Tools Help
O = g & BasinModel Manager 5 & = [none Selected— —None Selected— v %% B Bl .

s Meteorologic Model Manager

dem ¢! Basin Model [Basin 1]
= é_%[ Control Specifications Manager
; A % Time-Series Data Manager
(-1 St
= Meble_o,:olc |&2  Paired Data Manager
 cop[EF B Grid Data Manager
: ¢y Speahed Hyetograph
El Time-Series Data P - L
= Precipitation Gages
=l
=4 Gage 1 ificati
- Ci t trol ficati
“-[{f 013an1873, 00:00 - 31Aug2017, 00:00 e e 2
' | New...
BL Create A New Control Specifications >
Components  Compute  Results 4
Name :| Control 1
> Meteorology Model  Basins  Options Description :| Control specification for dema| =
Met Name: Met 1 Cancd
Description: |meterological model for demo 1 =
Shortwave: | —None— ~
Longwave: -MNone— ~
Precipitation: | Spedfied Hyetograph w
Evapotranspiration: | —None— W
Snowmelt: | —None— ~
Unit System: | Metric v
Replace Missing: | SetTo Defadlt w

Figure No 13: Control Specification Manager#



demol
Basin Models
(= &4 Basin 1
[#-184 Subbasin-1
Meteorologic Models
-2 Met 1
{40 Spedified Hyetograph
- Control Spedfications
-~ 168)
- Time-Series Data
Precipitation Gages

= E‘% Gage 1

[i]-

[l 01Jan1973, 00:00 - 31Aug2017, 00:00

Components Compute Results

Figure No 14: Control Specification

9. Creating a Simulation Run

@ Control Specdifications

Name: Control 1

Description: |control specifications for demo -E

*Start Date (ddMMMYYYY) (01Jan1379
*Start Time (HH:mm) |00:00

*End Date (ddMMMYYYY) |31Aug2017
*End Time (HH:mm) |00:00
Time Interval: i1 Day

To create a simulation Run go to Compute>>Create Compute=>Simulation Run. Accept the default name
Run 1 and then accept all the default models and finish creating the run. If you had more than one model for

Basin, Meteorology and Control specification, you get to select them during this step. Because we have only
one model for each, the process is straight forward. Save the project.

Running a Simulation

Once a simulation run is created, select the simulation by going to the Compute tab in the watershed explorer

and select the run as shown below (see

Step 1: Click on Compute

result in figure no 16).

Step 2: Create Compute>>Simulation Run

Step 3: Name- Runl
Step 4: Select Basin 1

Step 5: Select Metrological data (Metl)
Step 6: Select Control Configuration (control 1)

B2 HEC-HMS 42,1 [Di\hechms\demo Jadamol.hms]
File Edit View Components Param(umpute Results Tools Help

0SS \4.

Create Compute

Depth-Area Analysis Manager
Met 1

-4 specified Hyetograph

demal % Simulation Run Manager
g';ﬁ":;di‘s % Optimization Trial Manager
i #1144 Subbasin-1 { Forecast Alternative Manager
|| Meteorologic Models %

Uncertainty Analysis Manager
Control Spedifications

__ Multiple Compute...
Time-Series Data Compute
[=- | Predpitation Gages
E-EY Gage 1

[ 013an1979, 00:00 - 31Aug2017, 00:00

Components  Compute  Results

1£5) control Specifications

Hame: Control 1
Description: |contral spedifications for demo | ]

“Start Date (ddMMMYTYY) |0112n 1973
“Start Time (HH:mm)
“End Date (ddMMMYYYY)
“End Time (HH:mm)
Time Interval: |1 Day

00:00
21Aug2017
00:00

<

NOTE 10008:

Begin opening p
NOTE 10019: Finished openin
NOTE 10604: 32 missing or i

2 Simulation Run...

Optimization Trial...

Sl mE = -

Forecast Alternative...

Depth-Area Analysis..

Uncertainty Analysis...

2 Create a Simulation Run [Step 1 of 4]

A simulation run must have a name. You can give ita
descripiion after it has been created.

Mame: [Run 1

To continue, enter a name and click Next.

Cancel

& Creste a Simulstion Run [Step 3 of 4] b

Selected basin model "Basin 17. A simulation run includes
a meteorologic model. Select one from the list below.

Name Description

& Create a Simulation Run [Step 2 of 4] X

A simulation run includes a basin model. Select one from
the list below.

Name

Description

< >

To continue, select a basin model and click Next

- < >

Cancel

B&l Creste a Simulation Run [Step 4 of 4] X

Selected basin model "Basin 1" and meteorologic model
"Met 1°. A simulation run includes a control specifications.
Select one from the list below.

| Name

Description

To continue, select a meteorologic model and click Next.

=Back Cancel

Figure No 15: Run Method

Select a control sgecifications and click Finish.

=Back Cancel
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Figure No 16: Result
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EXERCISE 6:

HYDROLOGICAL MODELLING USING HEC-HMS
Kainfall Runoft Analysis through given input data (see in table no 1)

3 [temn fcontent Type) “alue
ne
1 Area of Basgin 1 4285 53 km
Area of Basin 2 185 5g km
2 Reach Length 300m
K Lozs hethod S5 Curve Mumber
4 Transform Method S8 Unit Hydrograph
3 Basze flow Method Mone
& Curve Number 13
7 Irapervious (%) 0.0
B Craph Type Standard (FEF484)
4 Lag Time 10, &0
10 ] Precipitation Time 01 Jan 197%to 31 July 2017
11 Data Source Manually Entry
12 TTnit Incremental Millimetre
13 Tirne Interval 1 Day
14 Routing hethod huskingum
15 | Muskingurn K (HRD 1
la | Muskingum X 0,22

Table No 1: Data input

1. Create a New Project (demo2):
step 1 Click on Filer>New

Step 2 (ive details of project
step 3 Create, after that show in dialeg box (red box)

File Edit View Components Parameters Compute Results Tools Help

Mew... Ctrl+ M TR 5 L. | B e B 4y

Yome i B T S T gy None Seleced— —Mone Selected—

g e - 2@
Import ¥

&5 Create a Mew Project >
Save Ctrl+5
Save As... Mame: |demo2
Delete,..  Ctrl+D Description: |Runoff modelling for 2 sub basin f=]
Rename... Location: |D:hechms
Phint: Default Unit System:  Metric w
Exit Cancel
demol

demoT sults & HEC-HMS 4.2.1 [D:\hechms\d
Project 1 File Edit View Components P3
demo

s E& %+

demo?2

Description: |Runoff modelling for 2 sub basin F=]
Output DSS File: |D:\hechmsidemo2idemo?.dss =

Figure No 1: Create New Project



2. Basin Model Manager

21 HEC-HMS 4.2.1 [D:\hechms\demo2\demo2.hms] =
File Edit View Components Parameters Compute Resul
Current basin models

O @ JA) Basin Model Manager

: z New...
M = Meteorologic Model Manager
3 Basin Mod Control Specifications Manager
S Time-Series Data Manager ' — -
2 Paired Data Manager & Create A New Basin Model 4 b
% Grid Data Manager Name :| Basin 2
Description ;| Runoff modelling for 2 sub basin| =

Components Compute Results

Project

Name: demo2

Description: |Runoff modeliing for 2 sub basin =]
Output DSS File: |D:\hechms'demo2\demo2.dss =

Figure No 2: Create new Basin Madel

3. Create Basin: same input as exercise 5

ODe & & LI el |L‘§'70 A |l qa é!” b tl_ij —No ~Plone Selected— vl EEH S
dema 4 Basin Model [Basin 1]
= | Basin Models

129 Subbasin-1
#1549 Subbasin-2

[+ in-
=y SUbbasin-1 & Subbasin-2

Figure No 3: Sub basin

=
4. Create outlet: Simple click on sink creation tool '™ | after that click on window
Su|  Current basin models
Basin 1 | New...
B Create A New Sink Flement ik
Name : Oul‘iel“
Description : =

s

Figure No 4: Outlet



Give the name of sink element (Outlet)

& HEC-HMS 4.2.1 [D:\hechms\demo'\demo.hms]
File Edit View Cclm_p_onents Parameters Compute Results Tools_ Help

D = H é':? k ‘f’ Q l-f',. LN CTJ 'f—tg” L?E —ione Selected-- ~Mlone Selected—

v % B E W e

demo ! Basin Model [Basin 1]

=] Basin Models
Ew
&4 Subbasin-1
14 Subbasin-2
é Outlet

2.. Subbasin-1

Components Compute  Restits

S5 Basin Model
Name: Basin 1
Description: =l
Grid Cell File: =
Local Flow: Mo o
Flow Ratios: No w
Replace Missing: Mo o |
Uit System:  Metric o
Sediment: Mo ~
Water Quality: No o

2, subhasin-2

& Outlet

<

Figure No 5: Basin & Outlet

5. Create reach

MNOTE 10008: Begin opening project "dema” in directory "D:‘hechms'demo™ at time 07Aug2018, 09:32:16.
MOTE 10019: Finished opening project "dema”in directory "D:Yhechms'demo™ at ime 07Aug2018, 09:32: 16,

Simple click on reach creation tool & after that click on window

Give the name of reach element (Reach-1)

&
bSu Current basin models
-BESJI'I i New...
Copy

ename.

2= Create A New Reach Element

Mame :

=

Cancel

Description :

Figure No 6: Create Reach

Subbasin-1




6. Fill all input in sub basin1

demo2
=+ | Basin Models
- &) Basin 2
Mo Canopy
Mo Surface
5C5 Curve Number
; 5CS Unit Hydrograph
e Mo Baseflow
=15+ Reach-1
Muskingum
e Mo Channel Loss
- Subbasin-2
L et

154 Subbasin  LosS  Transform  Options

Basin Name: Basin 2
Element Name: Subbasin-1

Initial Abstraction (M)
*Curve Number: |50

*Impervious (%) 0.0

£

Basin Name: Basin 2
Element Name: Subbasin-1

Description:
Downstream: lRea_ch—l
*Area (KM32) 4285
Latitude Degrees:
Latitude Minutes:
Latitude Seconds:
Longitude Degrees:
Longitude Minutes:
Longitude Seconds:
Canopy Method: | --MNone--
Surface Method: | —None—
Loss Method: | SCS Curve Number

Transform Method: | SCS Unit Hydrograph

Baseflow Method: |-Mone—

Figure No 7: Sub basin 1 Input

7. Fill all input sub basin 2

|51 MO SUFTECE

SC5 Curve Number

SCS Unit Hydrograph
=[5 Mo Bazeflow

=45 Reach-1

: Muskingum

[2] Mo Channel Loss

BN Subbasin-2

Mo Canopy

Mo Surface

SCS Curve Number

5CS Unit Hydrograph

- [Ig No Baseflow

E, outlet

124 Subbasin LosS  Transform Options

Basin Name: Basin 2
Element Name: Subbasin-2

Initial Abstraction (MM}
“Curve Mumber: (30

*Impervious (%) 0.0

185 Subbasin  Loss Transform Options

Basin Name: Basin 2
Element Name: Subbasin-2

Description:
Downstream: | outlet
“Area (KM2) 195
Latitude Dearees:
Latitude Minutes:
Latitude Seconds:
Longitude Degrees:
Longitude Minutes:
Longitude Seconds:
Canopy Method: | —MNone-—-
Surface Method: | -—MNone—

Locs Methed: | 5CS Curve Mumber

Transform Method: | SCS Unit Hydrograph

Bazeflow Method: | -Mone-—

Figure No 8: Sub basin 2 input

Loss Transform Options

(&4 Subbasin  Loss Options

Basin Name: Basin 2
Element Name: Subbasin-1

Graph Type: | Standard (PRF 434)
*Lag Time (MIN) &0

154 Subbasin Loss Transform OI:”:"-""|

Basin Name: Basin 2
Element Name: Subbasin-1

Observed Flow: | —fdone—

Observed Stage: | -flone—

Observed SWE: | -flone—

Elev-Discharge: | -Mone--
Ref Flow (M3/5)
Ref Label:

&4 Subbasin Loss Transform  Options

Basin Name: Basin 2
Element Hame: Subbasin-2

Graph Type: |Standard (PRF 484)
“Lag Time (MIN) |10

|55 Subbasin Loss Transform Options

Basin Name: Basin 2
Element Name: Subbasin-2

Cbserved Flow: | —Nons—-
Observed Stage: | —Mone-—
Observed SWE: | —None--
Elev-Discharge: | —Mone--
Ref Flow (M3/5)
RefLabel:

&

AL



8. Keach Input:

] demai“
= Basin M!:udels \\s Reach Routing  Options
-::--{E_l Basin 2
i ;
st b 5 bl:l _1
Z g Basin Name: Basin 2
T ! Element Name: Reach-1
PoF I Muskingum _
- ~[E No Channel Loss Muskingurn K (HR) | 1
-5y Subbasin-2 *Muskingum ¥: |0.22
i,
= DUt!Et Subreaches:
=3 Meteorologic Models
P e Metl
Control Specifications
Tirma-Sariae Mzt &p Reach Routing Options
>
(A Reach Routing Options Basin Name: Basin 2
Element Name: Reach-1
Basin Name: Basin 2 Observed Flow: [—None—
ELTEIA T AT Observed Stage: |—one—
Description:
Elev-Discharge: |—Mone—
Downstream: | outlet
Ref Flow (M3/5)
Routing Method: | Muskingum w
Ref Label:
LossGain Method: | —Mone-- w

Repeat all process for Metrological, Gauge & Run from exercise 5

Touare algo give more gange site

For Gauge site: You can alzo give more gauge site

4k



Exercise 7-10: HEC-RAS 1D-2D Modelling & Flood Inundation
mapping

Importing Geometry data into HEC-RAS
1.Open HEC-RAS software (Fig. 1).

BB HEC-RAS5.03 =
File Edit Run View Options GISTools Help

L = e e g e A PR A o

®| ~|F || ¥]n

il
>

Project:

plEs

X

Plan:

Geometry:

Unsteady Flow:

I
I
[
Steady Flow: |
[
I

Description :

J [Us Customary Units

Fig. 1
2. Go to HEC-RAS 5.0.3 = Options—> Unit System (US Customary/SI)... (Fig. 2)

B HEC-RAS 5.03 -
File Edit Run View  Options GISTools Help

X

w”|EI| X{If_;—|—£[ Program Setup b ¢|Z|§IP—\I i;_; EIIDSSI M
Default Parameters >

Project: )

Plan: [—— Unit system (US Customary/Sl) ...

Geometry: [— Convert Project Units ...

Steady Flow: Convert Horizontal Coordinate Systems ...

Unsteady Flow: | |

Description : | _l |US Customary Units

Fig. 2

3. HEC-RAS window (Fig. 3) will appear. Sclect System International (Metric System). Click
Ok.

4. RAS acknowledge window will appear. Click Yes.

HEC-RAS

Select Units System

" S Customary
(¢ System International (Metric System)i

[ Setas default for new projects

OK Cancel Help

Fig. 3




5. Save the new project by going to File>Save Project As. Select working directory and
save as hame.prj as shown in fig. Fig. 4. Click OK



Save Project As

Title

File Name

Ukashi

[P

Selected Folder ~ Default Project Folder Documents

d:\

PROJCS['WGS_1984_UTM_zone_44N",GEOGCS['G

oK cancel | Hep |

po.pri

Create Folder ... |

Ed:\ A
(1 AP_Classification

([[)Beas_Data

([ cfrbackup-MPYICZIE

(LI New folder

(CINew folder (2)

() old work

Carka_1

[JPython

([Rajat

((ARajat LULC VIC trials
(JRajat_vIC_1km
[JRough
Cirout_prep
(Jroute_1.0 v

| £ d: [Acer DATA]

Belect drive and path and enter new project name.

6.To import the GIS data into HEC-RAS, Click on View/Edit Geometric Data
Geometric Data window (Fig. 5) will appear.

Fig. 4

X

¢ Geometric Data

File Edit Options

Tools  River
Reach

—

View Tables Tools

SAl2DArea|SAl20 Area
Conn EC Lines

B | DD nm

GIS Tools

2DArea

Storage | 2DFlow 3
Area Area BreakLine:

Editors

Help

&

2DAnea
Manfin
Regions

Pump
Station
(eF2

RS
12.99

- O

Plot WS extents for Profile:

o =]

Description :

~
Dinp

X

Junct.
L

Cross
Section

{

Brda/Cuhs

Inline
Structure

{

Lateral
Structure

B

Storage
ﬁre:g

1<)

0.5990, 0.2604

Fig. 5




7. Click on Fle=Import Geometry Data—= GlIs Format (Fig. 6).

File Edit Options
Mew Geometry Diata
Open Geometry Data
Save Geometry Data

Save Geometry Data As ...
Rename Geometry Title

Delete Geometry Data

Copy to Clipboard
Print ...

Import Geametry Data

Exit Geometry Data Editor

View Tables

Storage
Frea

20Flaw
Area

EA020 Ared
Cann

==

d. Import
Browse to

#5318 Format

Tools GISTocols Help
a|g&l20Areal  20Area 20 Araa Pump
BC Lines |BreakLinezl mannn Station
Eliiaza.d Regions P
GIS Format ...

USACE Survey Data Format ...
HEC-RAS Format ...

HEC-2 Format ..,

UMET Geornetry Format ...
HEC Stream Alignment ...
Mike 11 Cross Sections ...

C5V (Comma Seperated Value) Format ...

GML Format ...

Fig. 6

data file Fig. N will

GISZRAS RASImport.sdf file created in GIS, and click Ok

appear.



Import 2GIS Format data file

Title File Name Selected Folder _ Default Project Folder |  Documents |
*.sdf;*.geo D:\HECRAS
#This file is generated by HEC-GeoRAS Be GIS2RAS.RASImport.sdf 30:\
(J21may

(Ll Hec_Ras_data_AFG

o | cancel | Help Create Foider ... | [&4d: (acer paTA] -]
Eelect GIS Format file to import

Fig. 7

9. Import Geometry Data window (Fig. 8) will appear. In the Intro tab, select ST (metric) Units
for Import data as and click Next.

Import Geometry Data ‘

Intro | River Reach Stream Lines| Cross Sections and 1B Nodes | Storage Areas/2D Flow Areas and Connections |

| The import data has been read into a temporary geometry structure and
now can be incorporated into the current geometry file. Step through the
various tabs to select the desired import options. When all the

appropriate options have been set, press the Finished - Import Data
button.

Current RAS project units: | us Customary Units

Import data as:

Import data wil be converted from SI to US Customary on import.

| wext |  Fmished-mmportpate | cancel |

Fig. 8

10. Confirm the River/Reach data, make sure Import stream lines box is checked, and click
Next as shown in Fig. 9.



Impert Geometry Data

Intro River Reach Stream Lines | Cross Sections and 18 Nodes | Storage Areas/20 Flow Areas and Connectons |

Import File
Reach ints|Ri |Status | stream Lines
Reach i | | | v

Previous

Finished - ImportData | Cancel |

Fig. 9

11. Confirm cross-sections data; make sure all Import Data boxes are checked for cross-
sections (Fig. 10), and click Finished- Import Data (accept default values for matching
tolerance, round places, etc).



Import Geometry Data

Intro | River Reach StreamLines  Cross Sections and 18 Nodes | Storace Areas/2D Flow Areas and Connectons |
Node Types in Table
[V Cross Sections (XS) ¥ Bridges and Culverts BR/Culv) ¥ Infine Structures (IS) W Lateral Structures (LS)

¥ | Import As: l #R5=9 FNew=9 #Import=9
Check New Check Existing Reset

ImportRiver: | (All Rivers)
Import Reach:

1 Reach RS
1| River Reach 12442.72 12442,72 ~
2| River Reach 11926.64 11926.64 new 2
3|River Reach 10978.54 10978.54 new ~
4| River Reach 10379.48 10379.48 new ~
5|River Reach 9395.206 §355.206 new 1
5| River Reach 8290.536 8290.536 new ~

7| River Reach 7500.41 7500.41 new ~
8| River Reach 4818.605 4818.605 new ~
9 Reach 4142601 4142.601 ~

~Match Import File RS to Existing Geometry RS 7}

Matching Tolerance  [01 Match o Existing

[T Prctur

e Refe ~Round Selected RS
¥ GIS CutLines 2 decmal places 5 Round ‘
¥ Station Elevation Data
¥ Reach Lengths Generate RS Based on main channel lenaths -
I Manning's i Yaloes ar {only available when looking at a single reach)
W Bank Stations Starting RS Valse: [0 2 decimal place
F sctinn Expansion Coef = Fray m; Rs‘nmetell

nevt | Fiished -ImportData | Cancel |

Fig. 10

12. The data will then be imported to the HEC-RAS geometric editor as shown in Fig.
11.

¢ Geometric Data - (m] *
File Edit Options View Tables Tools GI5Tools Help
Plot WS extents for Profile:

U | g | g e A
5 S i
s, = | G | &b | i | @] ni <TH = =l

Junct: =

Sy
foid

\.\_r( 1 2“;!

11926 64 !

Struchure 1097854 |

20flon 1037

4818.605.

)
ot i |
[ 255206.75, 3403017.85

Fig. 11




13. Save the geometry file by clicking File—> Save Geometry Data as Ukashi. Click OK.

..........................

Cross
Section
tool.
15.You should see the cross-section window as shown in Fig. 12.
= Cross Section Data - Ukashi = O X
Exit Edit Options Plot Help
river: [ - I\,..‘ +.| Plot Options |~ KeepPrevXSPlots ClearPrev | ¥ PlotTerrain (if availal
Reach: iReach :J River Sta.:l 1244272 _] _] J Ukashi Plan:
Description ] J
Del Row Ins Row Downstream Reach Le - 1185
" Legend
Cross Section Coordinates [ Channel ——
Station | Flevation |515 42 ‘515 o8 i517 2 i Gro.und
i Teice | | IETTTRTETES— ) Bant s
_2|2%6.78 1179.11 [ Lo f_channel [ RoB
~ 3|53.5 1173.22 | 1 | T s
_4|80.34 1167.4 . . E
~ 5s0.58 1167.38 Main Channel Bank tahons .§
—6|107.13 1164.58 | LeftBank | RightBank 2 1m0
| 7|128.22 1163.83 /80.58 |128.22
_8]133.91 1163.63 Cont\Exp Coefficent (Steady ||
6 5
| 9/160.69 1164.59 | Contracton |  Expansion e
10| 187.47 1170.18 0.1 03
4. 76.47
s BT | 6o ; - : ; ;
0 50 100 150 200 250
Station (m)
Select river for cross section editing

. Next, click on the Geometry editor and select Edit and /or create cross-sections
Fig. 12

Note: Each cross-section in HEC-RAS has the following information:

Location: This is described by using three pieces of information: River, Reach and River
Station.

Elevation Profile: This is the profile view that you see on the right hand side in the cross-
section window. This profile is created by using the information from the station and
elevation columns in the Cross Section Coordinates table on the left. The numbers in the
station column shows the distance along the cross-section from left to right (looking
downstream along the flow direction), and the ¢levation column shows the elevation at each
station point. You can think of Station and Elevation as the (x,z) attributes for the cross-
section line. Each station/elevation point is represented by a black dot on the cross- section
profile.

Bank locations: These are represented by two red dots on the cross-section profile. The
location of these red dots is dictated by the station numbers for Left and Right Banks in
the “Main Channel Bank Stations” table in the cross-section window.




Roughness (Manning’s n Values): The horizontal line at the top of the cross-section profile
shows the distribution of Manning’n value along the cross-section. This distribution is defined
in the n Val column in the Cross Section Coordinates table. You will see that the n Val column
is not populated for each row. The values are only reported at stations points where there is a
change in the Manning’s n.

Distance to the next downstream cross-section: This information is presented in the
Downstream Reach Lengths table. The numbers for LOB, ROB and Channel represent the
distances to the next downstream cross-section along the left over bank, right over bank and
channel, respectively. These distances are computed by using the flow path features that are
digitized in HEC-GeoRAS.

Note: As we have the surveyed value of elevations on cross section lines, so we replace the
Station value and corresponding elevation value.

16. Go to working directory open sections_UKashi.xls file (Fig. 13) which consist the value

of distance (location) along with elevation values for each cross section lines.

id

llzwe  Tnset  Pesgelsyot  Tormulas  Dala  Tevew  View  Deveoper  Acrobat
g st il [ e [ e R = N ber 533‘\ 150 Normal 7 | Morral = i (w| I fieas

4 Zooy S | ! = | -

Fase o cormarpamar ||| B 4 W [HE || e A |SFEHE B wierge & Center ¢ || 8 i v [0 M :‘jﬂd;:’;\_ Rl',ﬁf; B Good Neusral Ik FEatiocete =or‘m:t 3 Clear
Uipbeare & temt &} Alignmen: Numrber % svles Lels
R3O0 - £ 117an
A 8 c D | E B G H | | J K | L | M il (6} P Q

1 |Cross 1 Cross 2 Cross 3 Cross 4 Crosa 5 Cross € Cross 7 Cross @
? Distance (m|Elevation (m))istance (milevation (mliastance (milevation {mlistance (m Elevatian (m) istance (revation [iatance (r:vation (stance (2vation (atance (evation (stance (
3 0 174,365 0.00 1198.530 g 1154 74 0.00 118C.893 0 1138795  0.00 1144.56 0 1123.76 0 110925 0.00
4 20 1169.235 10.00 1195451 5 1152 62 10.00 1182.944 1 1134295 1000 114075 2 11231 12 109935 10.00
o | 40 164 201 1HL6M 1" 1187 14945 200 1187 751 4 1104 2/ 201 1136 19 4 1Y B 2 B R
6 55 1164.000 30.00 1181 639 183 1147515 30.00 1180.671 5 1131835 3000 113026 12 111875 7 10081  30.00
7 60 1158.350 40.00 1178.165 33 1147 465 40.00 1174 400 11 1131730 4000 112404 27 41194 18 100375 40.00
8 75 1158.110 50.00 1171390 10 114588 50.00 1162.335 12 1120515 5000 112071 37 1118.03 32 109237 50.00
9 80 1157.550 60.00 1172 603 80 1140.965 60.00 1163.072 14 112954 6000 112034 4T 111827 30 10924  E0.00
jiv] 90 1157.030 70.00 170.221 70 1140 06 70.00 1156 596 24 112845 7000 112005 57 11182 40 108803 70.00
" U5 1158 340 LV 1168 245 B 1130 /4 a000 11448 828 4 TPy Eom 1119 842 B 111HBS he B E B0
129 ug 158,910 Q0.0 1164.802 = 1139075 EVLE) 1143115 44 1128305 9000 1119.43 (AR RRI ] Bl 1UEB.Lf
13 105 4159.080 100.00 1160.000 1139175 100.00 1140.808 62 1120050 10000 111942 ar 1119 77 1084.62
11 107 1160.630 101.97 1158422 1138875  107.37 1130.94¢ 68 1128515 10717 111914 o, 19.28 73 1083.15
15 110 1161.000 110.00 1151171 1138815 110.00 1135.847 60 112875 11000  1119.03 107 82 108215
6 120 1161.040 120.00 1151.847 1139075 120.00 1134.291 62 1123755 12000  1116.09 17 92 10e1.29
(kal 130 1160 770 17316 1143 887 1140 075 130 00 1134 467 B7 1123455 13000 111376 177 o7 10aE1 25
18 140 1159 960 130,00 1144 534 1139 5345 140.00 1134 14¢ M M22845 130500 11134 13r 112 108058
19 145 1166.855 139.49 1142 830 1130.976 150.00 1133.865 84 1122300 14000 111346 147 120 108024
20 150  1167.430 140.00 1142 860 114006 155.70 1133.866 a4 1121885 15000 111274 157 1121.06 132 1079.59
21 161 1167250 150.00 1153.114 114011 180.00 1133 687 104 1122.185 16000 111278 167 112153 142 1079.28
22 168 1164155 150.28 1153 42 1140.265  170.00 1133 411 {14 1122335 17000 1113.56 177 112048 152 1079.56
23 179 1164.455 160.00 1152.401 1140885  180.00 1132852 124 1122515 17149 1113.71 187 112087 153 1080.04
74 ghi] 1168 11 10 161120 1144 Hilh 190 (0 1107 8t 128 N20065 18000 11144 142 12068 16/ W2/
25 190 168.510 17322 115142 114784 200.00 1131.637 138 1123005 19000 11134 104 1 170 100957
26 195 1172.685 180.00 1154.128 1148775 210.00 1133.198 148 112320 20000 1114.24 187 170 1085.01
a7 200 1172.835 190.00 1155197 1153.205  220.00 1132792 156 1123.83 21000 1117.26 207 1111.83 182 1095.87
28 210 1173.020 192.20 1158 422 115412 230.00 1133.082 180 1124565 21540  1119.14 210 111553 193 1096.38
29 220 173375 200.00 1158.572 15777 23423 1132.966 168 1125 22000 112048 211 1107.54 205 1097.02
A0 230 EREER A0 1150 824 1188 445 240 11 1130 084 /9 124 h70 23000 1122 [k 210 1R AN UM 2R 20
31 220.00 1160.53 115031 24822 1132 946 108 112468 24000 112228 227 1107.38 233 10979 200.00
32 230.00 1161.795 1158.305  250.00 1140155 198 1124440 25000 112249 237 1107.67 241 109916 280.00
33 240.00 1165392 260.00 1142.355 203 112368 28000 112277 247 1107.84 248 1099.76
3 250.00 1170671 270.00 1143.167 218 112451 27000 1123.04 257 1108.32 252 1101862
351 260.00 1175705 280.00 1143 241 220, 112878 28000 112332 267 110862 253 110078

9



Fig. 13
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. . . < Cross Section Data - uttarkashi ic.d
17. Copy Distance (location) and elevation of T e -
cach cross section lines from excel file and || " PRy
; Riv Undo Editing \:|[= <+ | Potoptor
go to HEC-RAS’s Cross Section data 2l [N~ |
: ; ; : Read  Cut Ctri+X [10101.28 > 41
window. Click on cross section coordinate ] oy cmsc i)
. u i ¥ - "
sub W.mdow. It will select all station and p  Peste  Cev -
clevation values. Bl  CopyPlotToCliphoard OB Channel ROB
1 17  [o48.45  [1003.89
L Delete .. 120
_ 1 Tseris Manning's n Values ]
2| : ~——OB | Channel | ROB 119
| 3|59.63 1171.05 [ 1 ] E
1 i 1 4/89.44 1163.24 s
18. Go to edit and click on Paste (Flg 14) It — . S % 118
will replace automatic geometric data value ||| gl119.26 1160.81 | K Bk | RghtBank | 2
. : ~ 7]149.07 1158.8 104.86 200.15 17
with survey geometric data. —a|er088 P @
—9|200.15 1164.83 |~ Contracton: | Expansion 116
10]208.7 1167.14 o1 03
_11|238.51 1178.72 LI 115
[Edit Station Elevation Data (m)

Fig. 14
19. In Manning’s n Values option assign 0.04 for LOB, Channel and ROB.

20. In main Channel bank Stations option, replace the value of Teft Bank and Right Bank by the
nearest values using data in excel file eg. First cross section replaces 44.28 by 40 and 176.79 by

179.

21. Click on LLITOW tool for going to next cross section.

22. Cut Line Extension Option window will (Fig. 15) appear. Click on Accept edits and adjust cut

line option.

Cut Line Extension Options

The cross section has GIS cut lines specified, and the starting or ending station has been changed.
The cut line will no longer have the same length as the cross section. Which of the following do
you want to do?

| Cancel Edits |

1 Accept edits and leave cut line alone | Accept edits and adjust cut line

Fig. 15

23. Now window for next cross section elevation will come. Apply similar steps for others cross

section.



24. Close Cross Section Data window.

8
25. Go to Geometric Data window — File. Click on Save Geometric Data. Close Geometric Data
window.
Steady Flow
Entering Flow Data and Boundary Conditions
Flows are typically defined at the most upstream location of each river/tributary. Each flow
that needs to be simulated is called a profile in HEC-RAS. For this exercise, we will create
one hypothetical profile.
1. Inthe main HEC-RAS window, click on Edit >Steady Flow Data (Fig. 16).
B HEC-RAS5.03 = pod
File Edit Run View Options GISTools Help
ﬂ Geometric Data ... J£| vlﬁﬁﬁl?’;llﬁl%ll"—\ B EI@",;.SSl M
projec  Steady Flow Data .. " [:\kashi.pri =]
Plan: Cuasi Unsteady Flow (Sediment Analysis) ... il
Geomi Unsteady Flow Data ... : H:\Ukashi.go1
e Sediment Data ... L !
i Water Quality Data ... I _“
Descri .| [s1 Units

Fig. 16

2. Steady Flow Data window will appear. Enter hypothetical flow conditions for this
profiles enter 1 for number of profiles and 1396 in PF1 option as shown in Fig. 17, and
click on Apply Data.

T T AR T I Y |

Mile Optiors lelg

Erlen /Bl hnber of Profics (2000 mox): ’1 Bazch Bnundary Concitons .. I Appy Nata |
Locatinrs of Mow DEta Changes

Rvar: | river - adz Muttple.. I

noadh: |rH-J(Z|I LI r,'_iuerg:a_:llrh:.lq_‘lJ ﬂ Fultl A Fover ChiAnige oAl |

I low Change Locabon Frofle Hames and | iow Hates |

|[Edt steacy Aow data For Ehe profics (m3/s)

Fig. 17

The flow conditions defined in the above window are upstream conditions.
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3. To define downstream boundary, click on Reach Boundary Conditions. Then select
Downstream for uttarkashi Reach, click on Normal Depth, and enter 0.0002 (Fig. 18).

Click OK.
T e )
Steady Flow Boundary Conditions
@ Set boundary for al profies (" Set boundary for one profile at a tme |

Avaiatle External Boundary Condtion Types

Known W.5. I Critical Depth

River Reach Profile Upstream Downstream |
river reach al al Dep
1|
|
Steady Flow Reach-Storage Srea Optmization . | 0K Cancel Help |
Enter to make the boundary for selected location normal depth.

Fig. 18
4. Now come to Steady Flow Data window. Go to File - Save Flow Data.

5. Save Flow Data As window will appear. Select working directory and give the title (eg.
uttarkashi steady flow data). Click OK. Close the Steady Flow Data window. Now we
are ready to run HEC-RAS!

Step 10: Running HECRAS g icc ncsos o

1. In the main HEC-RAS window, click | fie Edit [Run| view Options GIS Tools Help
on Run-> Steady Flow Analysis (Fig. | =1y x Steady How Analysis .. ' ﬁﬁ[f’/”]k
1 9). = Unsteady Flow Analysis ... [
Project: Sediment Analysis ... = ﬁ
Pian: Water Quality Analysis ... — (=
Geometry: Hydraulic Design Functions ... — ﬂ
Sheathy Run Multiple Plans ... = ﬁ
Unsteady B gin RAS-MODFLOW Coupled Mode .. -
Description
— Uncertainty Analysis L
Fig. 19

2. Steady Flow Analysis window (Fig. 20) will appear. Give Short ID (eg. Uk). Select Subcritical
Flow Regime. Click on Floodplain mapping check box. Click on Compute button. The model will
run.

13



5 Steady Flow Analysis

File Options Help

Plan: Plano1

shortID Uk

Geometry File : Jleashi

Steady Flow File

Plan Description

JUkashi_Steady_Flow

i~ Flow Regime -
(¢ sSubcritical
(" Supercritical
" Mixed
- Optional Programs
¥ Floodplain Mapping

| Compute

Enter to compute water surface profiles

Fig 20

3. HEC EAS Finishes Computations window
(Fig. 210 will open. After successful
sitmulation, Cl0Se the computation window
and the steady flow Analvsis window.
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Tk e ety TR
booardarmd Wik GrcarwT

LaF P EC] R EF FEY
TR e
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G
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Fig 21

4. Save work plan as Plan 01 on View profiles button % on HEC-EAS interface. Profile Plot

window (Fig. 227 will appear. Check longitudinal profiles for the stream zections. Close window.
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9 =z Profile Plot = Od 4
g File Options Help
Reaches .. |#|t] Profiles .. |®|®.] [ Plotinital Conditions  Reload Data
Ukashi Plan: Plan 01 5/23/2018 —J
e River Reach
11807 Legend
1160 EG PF1
WS PF 4
Y

—~ 11407 Crit PF 1
E e —
= Ground
H 1120
=
o
w

1100 ]

1080

1080 : T T : .

0 2000 4000 8000 2000 10000
ain Channel Distance (m}) /_‘

Fig. 22

3. Click on View cross sedions button E] on HEC-RAS interface. Cross Section window (Fig. 23)
will appear. Review cross-sections and water surface ¢levations at cross-sections. Close window.

= Cross Section — | >
File QOptions Help
wver: [N -] .| ® | | +tm| _ReloadData
teach: [Reach =| River sta.: [12492.72 ~] 4t
Ukashi Plan: Plan 01 5/23/2018 _J
N 04 I 04 I 04 i
ity Legend
11741 e i
1727 EGPF1
= 11707 WS PF 1
i Crit PF 1
% g Ground
£ 11541 _—— .
M q1e2] ' Bank Sta
11601
11581
1156 - : : : .
50 100 150 200 250
Station (m}) ;
al ; rl
Fig. 23
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. Click on View summary output tables by profile button E on HEC-EAS interface Profile

Cutput Table window will show as Fig 24. Eeview results.

B3 Profile Output Table - Standard Teble 1 = O et
Fie Cgtions 5Std. Tabler Locations  Help
HEC-FAS Plan; Uk FRiver; River Reach: Reack Profile: FF 1 Fzload Data
2eahi  |River S [Frofle | @Tuld [minchiEl[w.s. sev Gitw S, [= 6 Bev |E.G. Stope| ve il [ =hon Arza | Top wid b 5ieude 2 chil
mzfe) ] {mi i) m) {rr ) {ms) mz) i
Feach | 17447.72 |FF - T3en M 1157.65 11251 CIAZ 51 1FA9E 0010011 ROF| JR4.5R  RE.57 .33
Qeach 1192e.04 |FF L L355,00 114‘5.53_ 11535482 118662 11E7.15 0,009134 E.GE_ 239,33 83.06_ 0,34
Acach 10078, 51 |FF [306.00] 1138.68| 1112,11 114201 1143.2¢( 0.200C77F 177 323.15 135,85 0,00
2edch 1037598 |PE L L395,00| 113285 1136.08 1135068! 1137.21| 0,010733 483 MRS5S 13204 Q.37
2each 5355.206 |FF _ L3i9G.00] 1124.89| 112561 _125 33 1_26.35) 0.00879G 466 356.53 | LI¥.93 0,33
Irach 8790.536 |FF - I'{Q_q.l'll'l 117274 111737 "115R83 171R.3¢ 0.006£16 4.ﬁ1_ ?1_?.4'31 A A3 .79
each 7500.41 |FF L [355,00 110?.6:"_ 11_11.'1'§| 1111 190 1:12,3E 0,009153 4.42_ 307.85 oL 0,89
318,505 |FF L306.00) 107C, 28| 1034.91 10E5,68 | 0,003=55 3.81 373.50 89,31 0.50
142,501 |FF 1 107274 103501 073 17 1085,120 Q.000z200 168 1006.93F I3
Total fow ir cross soctior,

Fig 24

Exporting HEC-RAS Output to HEC GeoRAS

1. To export the data to ArcGIS. Click on File 2Export GIS Data... (Fig

window. [ HEC-RAS 303

Sile | Fdir Run Wirw Orfons 535 Torls

Hrlp
M Prooeck .

T p—

Uper Projezt ..
Save izl e
Save sl ds T
Rerieiniz Propedt Tids
Czlele Project .

Prujecl Surnenasy ..

Impuort KEC-Z Cala
Imipurl FEC-PAS Dala. .
Cenereie Fepoil o
Epuorl E5 D e
Export to HEC-DSS ..
Rectore Bachup Data

Cebug Feport (compres cumer: plan ©le! .
Exit

df Feachipn

Fig. 75

2 GIS Export window will open. Click on options which you want to export as show in Fig.

1a
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26.

G5 Export

Export File: ]d:ﬂJkashi.RASexpurt.sdf Browse ...

Reaches and Storage Areas to Export

Select Reaches to Export... I Reaches (1/1)

ect Storane &reas to Export ‘ Storage Areas (0J0)

Results Export Options
W Water Surfaces v Siiater Surface Extents! Select Profiles to Export ...

Profiles to |22
Expaort:

Flow Distribution {only averaged LOB, Chan and ROB values available Additional Information
v velodty [~ Ice Thickness {where available)

¥ Shear Stress
V¥ Siream Power

—Geometry Data Export Options -
W River (Stream) Centerlines

Additional Proper ties

v User Defined Cross Sections W Reach Lengths
(all %5's except Interpolated X5's) W Bank Stations (improves velodity, ice, shear and power mapping)

W Interpolated Cross Sections [ | ias

{* Entire Cross Section v Ineffective Areas

" Channel only ¥ Blocked Obstructions

[ ¥ Manning's n
Export Data J Close J Help J
Fig. 26

3. Click on Export Data button. RAS acknowledge window will appear. Click OK. (It will create a
SDF file in your working directorv).

4. Save the HEC-RAS project and exit. We will now return to AreMap to create a flood inundation

map.
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Unsteady Flow Analysis:

Flows are typically defined at the most upstream location of each river/tributary. Each flow
that needs to be simulated is called a profile in HEC-RAS. For this exercise, we will create
one hypothetical profile.

1. Inthe main HEC-RAS window, click on Edit 2Unsteady Flow Data (Fig. 27).

BN HEC-RAS5.03 = X
File Edit Run VWiew Options GISTocls Help

= Geometric Dat ... j - v‘ﬁﬂ;{%ﬂé‘g“& B IEIE|‘5551 M
Projec Steady Flow Data ... | H:ECRAS\HECRASTraining\kashi.pri =
Plan: Quasi Unsteady Flow (Sediment Analysis) ... | [H:\HECRAS\HECRASTraining \Ukashi.p0 1

Geom Unsteady Flow Data ... B id:\HECRAS\HECRASTrainingUkashi.gd 1

Stead W id:\HECR AS\HECRASTraining Ykashi. f01

Sediment Data ... =
Unste : |
Water Quality Data ...

i _ _J [ST Units

Fig. 27

Descri

2. Unsteady Flow Data window will appear as shown in Fig. 28. Select the boundary condition
for river. Randomly we select flow hydrograph as upper boundary condition and normal depth
as downstream boundary condition.
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A Unsteady Flow Data
File Options Help

{. Boundary. Conditions.|| Initial Conditions |

Stage Hydrograph

Normal Depth

Flow Hydrogr aph

IFlove Hydr, | Rating Curve I

I Lateral Infiows "'*\‘—‘til- I Unifarm Lateral Inflow | Groundwater Interflow

1.5, Gate Openings \ Elev

AN

Precipitation

Controlled -3-‘.5‘%-: I Navigation Dams I 1B Stage/Flow l

Add Boundary Condition Location

&dd S& Connection .. I Add Pump Station , I
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3. Now come to Unsteady Flow Data window. Go to File - Save Flow Data.

Flew Hydrograph

River: River Reach: Reach RS: 12442.72

(" Read from DSS before simulation Select DSS file and Path
Fie: |
path: |
' Enter Table Data time interval; |1 Hour -

Select/Enter the Data's Starting Time Reference
" Use Simulation Time: Date: Time: |

% Fixed Start Time: Date: [028UG2018 _u|nme: [o0:00

No. Ordates |  Interpolate Mising Values | DelRow | Insrow |

Hydrograph Data

Date Simulation Time Flow
(hours) (m3/s)
1 01Aug2018 2400 00:00 1094.692
2 02Aug2018 0100 01:00 1094.458
3 02Aug2013 0200 02:00 1094..137
4 02Aug2018 0300 03:00 1093.912
5 02Aug2018 0400 04:00 1093.857
6 02Aug2018 0500 05:00 1093.803
7 02Aug2018 0600 06:00 1093.712
8 02Aug2018 0700 07:00 1093.599
9 02Aug2018 0800 08:00 1093.528
10 02Aug2018 0900 03:00 1093.492
11 02Aug2018 1000 10:00 1093.455
12 024ug2018 1100 11:00 1093.42
13 02Aug2018 1200 12:00 1093.456 -

~ Time Step Adjustment Options ("Critical” boundary conditions)
[V Monitor this hydrograph for adjustments to computational time step

Max Change in Flow (without changing time step):
Min Flow: |1000 Multiplier: {1 2

Fig. 29

4. Save Flow Data As window will appear. Select working directory and give the title (eg.
Unsteady Ukashi). Click OK. Close the Unsteady Flow Data window. Now we are ready
to run HEC-RAS.

Step 10: Running HEC-RAS
In the main HEC-RAS window, click on Run->Unsteady Flow Analysis (Fig. 30).

Geometry:
Steady Flow:
Unsteady Flo
Description :

B9 HEC-RAS5.0.3

- X
File Edit Run View Options GISTools Help
| ©  Steady Flow Analysis .. = || 2| ¥ | B|E| o M
Unsteady Flow Analysis ... !
e Hi: HECRAS\HECRASTraining \kashi.prj [ |
Sediment Analysis ... F
Water Quality Analysis ... 1 |5 \AECRAS \HECRAS Training \Ukashi. g0 1
Hydraulic Design Functions ... " [ \HECRAS\HECRASTraining\kashi. f01
Run Muttiple Plans ... d:\HECRAS\HECRASTraining\Ukashi.u0 1

Run RAS-MODFLOW Coupled Model ...

JlSIUnits

Fig. 30




16 5. Unsteady Flow Analysis window (Fig. 31) will appear. Give Short ID (eg. UK_Un_p).
Select Subcritical Flow Regime. Click on Floodplain mapping check box. Click on Compute
button. The model will run.

&, Unsteady Flow Analysis X
File Options Help
Plan : Ukashi_unsteady_plan ShortID |UK_Un_p F
Geometry File : |Ukashi g _'J I
Unsteady Flow File : | Unsteady_Ukashi ~| 8
Plan Description : F
Programs to Run J
[~ Geometry Preprocessor

[T Unsteady Flow Simulation
[T sediment

™ Post Processor

[V Floodplain Mapping

Simulation Time Window

Starting Date: 022062018 &) Starting Time: |00:00

Ending Date: D6AUG2018 & | Ending Tme:  |03:00]

Computation Settings -
Computation Interval: 1 Minute _¥| Hydrograph Output Interval: |1 Hour v
Mapping Output Interval: |1 Hour _¥| Detailed Output Interval: m
™ Computation Level Output
DSS Output Filename: |d:\HECRAS\HECRASTraining \Ukashi.dss E"']

[~ Mixed Flow Regime (see menu: "Options/Mixed Flow Options ...")

Compute l
Fig. 31

6. HEC RAS Finishes Computations window (Fig. 32) will open. After successful simulation,
close the computation window and the unsteady flow Analysis window.

Write Geometry Information

1
Layer: Complete .

[~ Steady Flow Simulation — —

| River: River Rs: 12462.72

Reachi  Reach Hode Type: _ Cross Section |
Profile: PR 1 |
|

[Plan: Plan 01’ (Ukashi.po1)
isim: tarted at: 23May2018 12:33:51PM

(Computations Summary

iC: Task Time (hh:mm:ss!
iCompleting Geor <1

metry

Steady Flow Computations(s4) <1
\Computing Maps <1
Complet= Process 1

| Take Snapshiat of Resuts_| T IRE
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1 D Flood inundation mapping
1. In ArcMap (if you closed Uttarkashi.mxd carlier, open it).

2. Click on Import RAS SDF file & button to convert the SDF file into an XML file.
Convert RAS Export SDF to XML window will appear.

3. In RAS SDF File option, browse to Flood_study_uttarka. RASexport.sdf . The XML file
will be saved with the input file name in the same folder with an xml extension as shown in
Fig. 33. Click OK.

Convert RAS Export SDF to XML X

RAS SDF File: |D:\Ukashi.RASexport sdf | 7

RAS XML File: | D:\Ukashi.RASexport xmi |

OK Close

Fig. 33

4. SDF2XML acknowledge window will appear. Click OK. 5. Now click on RAS

Mapping—>Layer Setup to open the post processing laver menu.

6. Inthe Layer Setup for post-processing, first select the New Analysis option, and name the
new analysis as Uttarkashi_Steady Flow2. Browse to UkashiRASexport.xml for RAS GIS
Export File. Select the Single, in Terrain Type select GRID and browse to srtm_dem_utm.
Browse to vour working folder for Output Directory as shown in Fig. 78.

HEC-GeoRAS will create a geodatabase with the analysis name (Uttarkasi Steady Flow2)
in your output directory. Accept the default 30 map units for Rasterization Cell Size. Click
OK.
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E Layer Setup for HEC-RAS PostProcessing

Analysis Type
() Existing Analysis
(®) New Analysis

RAS GIS Export File

Temain

(®) Single

) Multiple

Dutput Directory
Geodatabase
Rastenzation Cell Size

Uittarkashi_steady_flow

| Littarkashi_Steady_Flow2 |

| D \Ukashi RASexport smi |

Terrain Type (O TIN (@ GRID
Terrain |DAHECRAS‘\Hec_Ras_data_AFG'sitm_den| | (5 |

DTM Tiles Layer i

D ANHECRAS study 1| ttarkashi_5Steady_Flow2 |
UttarF:asPﬂ_Stead}'E
{ 31} | (map units]

oK || Help || Cancel

Fig. 34

& new map (data frame) with the analysis name (Uttarkasi steady_flow) will be added to

Lrehfap with the terrain data.

Next click on RAS Mapping 2Import RAS Data.

Import BEAS Data window (Fig. 35) will appear. Click O,

S 1 paal %5 Daia

Vagprazsn

e Tk (Dol DORATG G285 AT petord

Hal e

Hesaage 4

[

-

oo | ke Cercel

Fig. 35

10, Bimilar to during export, vou will see a series of messages during the import as shown in Fig.

36,
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[EZ Import RAS Data

RAS File | D:\Ukashi RASexport xmi

5/23/2018 3:55:37 FM

| Informative

| RAS data imported to (515 successfully!

Messages
Start Time I'I_J'I:psesage Message
|5/23/2018 355:20PM | Informative | Completed importing RAS data to GIS...
|5/23/2018 355:26PM | Informative | Trying to create velochty points...
- B/23/2018 3:55:27 PM : Informative -Trg,'ing to create ice poirts....
- h/23/2018 3:55:27 PM . Informative -Trg,'ing to create shear stress points...
. h/23/2018 3:55:28 PM Informative :Trg,'ing to create stream power poirts...
|5/23/201835528PM | Informative | RAS output addedtomap...
5/23/2018 355:37PM | Informative | Bank points created. .
. 5/23/2018 3:55:37 PM l Informative Layer symbology applied...

Fig. 36

Close

11. This will create a bounding polygon, which basically defines the analysis extent for

inundation mapping, by connecting the endpoints of XS Cut Lines {(Fig. 36).
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@ Uttarkashi.mxd - ArcMap

File Edit View Bookmarks Inset Selection Geoprocessing Customize Windows Help

Ds@& & o’ x

RN — [ L] T

Editor - |y . | Temain Preprocessing = Terrain Morphology = Watershed Processing = Attribute Tools = Network Tools = ApUtilities~ 5. & #, == 33 THI@ P« Help -
_. Table Of Contents ax ~
§ = = RAS Geometry = RASMapping~ ¢ 8¢ LIl & = w £ ApUtilities = Help~
Q | & = Uttarkashi Steady Flow?
ux 1 (3 DAHECRAS\study \Uttarkashi_Steady_Flow2\U
<A = P RasResults
A £ B BankPeints
-
Power
Stress
i elocities |
Water Surface Edents
(s CutLines 3D
& -
(1) = & RiverD
@ Xs Cutlines
-
o 5 B Buanding Pulygon
& ]
2 = & HOLDER \
B WaterElevationsByKSection
9 ProfileDefinition
e 9 StreamPoints
& VelocityData
5 ShearStressData
1 5] DAHECRAS\Hee_Ras_data AFG\
M
< »j@ie|en < >

Drawing~ K (=) £ [0~ A ~

ﬂ QO Type here to search

12. After the analysis extent 1s defined,
are ready to map the inundation extent.

257498,089 3401641,208 Meters

|RAS Mapping v i ¥ 1l & < < &2 Aputilties v Help ~

we . Layer Setup

Import RAS Data

Click on RAS Mapping—> Inundation

Mapping—> Water Surface

Generation
(Fig. 37).

13. Water Surface TIN window (Fig.
38) will appear. Select PF1, and
Click OK.

Fig. 38

Velocity Mapping

Ice Mapping

Shear Stress Mapping

i Inundation Mapping 4 Water Surface Generation

Floodplain Delineation Using Rasters

Fig. 37

Water Surface TIN.

Select Water Surface Profile

OK

Help

Cancel
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14. This will create a surface with water surface elevation for the selected profile. The TIN (t
PF1) that is created in this step will define a zone that will connect the outer points of the
bounding polygon, which means the TIN will include area outside the possible inundation as
shown in Fig. 39.
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Fig. 39

Note: At this point we have a water surface (f PF1) TIN, and we have an underlying
terrain (srtm_dem_utm). Now we will subtract the terrain (Srtm_dem_utm) from the
water surface TIN, by first converting the water surface TIN to a grid.

15. Click on RAS Mapping->Inundation Mapping—> Floodplain Delineation using Rasters
(Fig. 85).
r|RAS Mapping v ¢ a¢ Ll & = = & ApUtilities v Help v |

g Layer Setup

Import RAS Data

Inundation Mapping 4 Water Surface Generation

€ Velocity Mapping Floodplain Delineation Using Rasters

a

Ice Mapping

£

Shear Stress Mapping

Stream Power Mapping

Visualization »

Postprocessing Utilities  p

M O W e W

TEET
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16. Floodplain Delineation (Fig. 40) will appear. Again, select PF1 and click OK.
Floo :

Select Water Surface Profile

R—— oK

in Delineation X

Help

Cancel

¥ Add Output Layers ¥ Draw Output Layers
¥ Smooth Flocdplain Delineation ™ Merge Floodplain Features
A
Fig. 41

17. HEC-GeoRAS acknowledge window will appear. Click OK.

18. srtm dem utm is subtracted from the water surface grid. The area with positive results
(meaning water surface is higher than the terrain) is flood area, and the area with negative
results is dry. All the cells in water surface grid thatresult in positive values after subtraction
are converted to a polygon, which is the final flood inundation polygon as shown in Fig. 87.

TS R — 7
i CI LR | RAS ooy - RS Mppin - 0¢ g L 5F o e 8 Ml meb- ik,
e L&
1| likarkcank] e mady |l 5

= O DI RAT

19. Save the ArcMap document.
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2D Flood Inundation Modeling

HECRAS version 5 and later includes functionality to analyses water flows moving across a
surface. this is known as 2D flood modelling and provides more accurate modelling of water
movement across a surface. For 2D flow modeling followings steps are accomplished.

1. Convert DEM to Float in ArcGIS using the following command Raster to Float (In
ArcToolbox goto 3D Analyst Tool/Raster Math/Float) as shown in figure 42. In input raster
“srtm_dem utm” and Output raster “dem.flt” as shown in figure 88.

Catalog 0o x "\“ Raster to Float - O X
e-yaly @ E-|eklE

Location: |" , Float od

Input raster
-~ | srtm_dem_utm Rl =
= &l System Toolboxes - ; =
L @ 3D Analyst Tools thx &Oumut floating point raster file
= & 30 Features [ D:\HECRAS\HEC_t'dem. fit |
& & CityEngine
E %1 Conversion
e i Data Management
) %1 Functicnal Surface
= %_ Raster Interpolation
=] %1 Raster Math
#.. Divide

‘-\, Float
5 Int
"‘\ Minus
“ Plus
‘\ Times
H %-. Raster Reclass
(£ ] Q- Raster Surface
H ﬁ- Triangulated Surface
= %- Visibility
= % Analysis Tools.thx
= @ Arc Hydro Partial Terrain Update.tbx
£ % Arc Hydro Tools.tbx
= @ Cartography Tools.thx
= @ Cenversion Tools.tbx
# @ Data Interoperability Tools.thx
= % Data Management Tools.thx
= @ Editing Tools.thx
£ @ Geocoding Tools.thx
% &) GeoHMS Tools.thx
= a Geostatistical Analyst Tools.thx
e ? Linear Referencing Toolsthx ~
< >

@ Search m Catalog

oK Cancel Environments. .. Show Help >>

Fig. 42

2. Open HEC-RAS and create a new project and defines the unit system:

* Click on File > New. Select a location and name for the new project

* Click on Options > Unit System to confirm the units (this example is using Metric units).

3. The first step in developing a terrain data set is to open RAS Mapper. This 1s accomplished
by selecting GIS Tools from the HEC-RAS main window, then selecting RAS Mapper, or
by pressing the RAS Mapper button on the HEC-RAS main window. When this is done,
the window shown in figure 43 will appear.

4. In RAS Mapper firstly set the projection for the project. In Tools menu select “Set
Projection for Project” and defines the projection parameters or import from the file as
shown in figure 44.
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Options

GiSTools Help

| $w| |45 ® | #| 7 ¥n| 2

ol Jak

Geometry:

Unsteady Flow:

[
[
[
Steady Flow: [
[

Desaription &

US Customary Units
I

KASMappEr
File Tools Help

kb@@Qxxe>2>ru NS

= o X

)

I:[Geomdna
| CIResus
- [IMap Layers
[[ITemains

‘Messages | views | FTonie Lines

Fig 43

k Mapper

Tools | Help

Set Projection for Project ...

Web Imagery ...

New Terrain ...

Add Map Layers ...

New Land Cover ...
Import NLD ...

Manage Results Maps ...
Render Mode Options
Show Legend

Show Profile Line Distance

Foeaxsteru zEs

Spatial Reference Projection File

N

ESRI Projection File (".pri): |

Spatial Reference Projection File

ESRI Projection File (“pri): [D\HECRAS\Hec_Ras_data_AFG \cross_section_modfy pr \

Paste
o

PROJCS["WGS_1984_UTM_Zone_44N" GEOGCS['GCS_WG5_1934" DATUM['D_WGS_1984" SPHEROID
["WGS_1984" 6378137 0.298.257223563]] PRIMEM["Greenwich".0.0L UNIT

["Degree” 0.0174532925193433]]. PROJECTION[ Transverse_Mercator'], PARAMETER

["False_Easting” 500000.0) PARAMETER|"False_Narthing”0.0],PARAMETER"Central_Meridian" 81 0] PARAMETER
["Scale_Factor” 0.9996] PARAMETER|"Lattude __Of_Origin",0.0],UNIT[" Meter",1.01}

0K Cancel

Fig 44

5. In RAS Mapper to add a terrain, Click on Tools > New Terrain
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This data will be used to create a Terram — in HECRAS the terrain 1s saved as a file

extension .hdf.

Click on Create to import the Terrain. Note under the Terrains layer is a new layer. Make
sure that Terrains 1s ticked on, then right click on Terrain and choose Zoom to Extents to
see the full extents of the terrain model in RAS Mapper. Terrain data is exported in jpg

Help

+Layer

Input Temain Files
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%] || # Browse for Terrain raster files X
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HOUR > [ demdit FLT File
= ¥ Downloads  # ] =
[ Documents E
B Dirtiras > ¥ S * Eancal
8 File name: | dem.fit | |RasterData pusitriitradn v |
[ v ] | Gonea

Insert

Fig 45

Design Layout References Mailings Review
New Terrain Layer
Input Tenain Files
4 Flename Projection Cel Size Rounding Info
% dem fit | (Same as Project) | 30 ina}
Output Terain File

Rounding (Precision): 1/32

Filename:

~

Create Stitches

|d-\HECRAS\HEC_1\Temain\Temain hdf

Create

Cancel

format.(named terrain.jpg)

Fig 46
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Fig 47

6. In RAS Mapper to add a Map Layer, Right click on Map Layers and select Add map

data layers, (Using this option we can add exported terrain image as well as Google satellite
erc).

When prompted to sclect a file, use the file type dropdown bottom right to select images.

Tick on the image to display it in RAS Mapper. Right click on the image name to edit the

Image Display Propertics — a transparency can be assigned here as shown in Figure 48.
Then close RAS Mapper.

File Tools Help

L @AM erm ENS 9
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[CJResuits
EMapLayers
i -[AGoogle Satelite [ms]
&[] Temains

Google Satelite

Transparent Solid.
A et Moty

oK Close

Messages | Vievs | Profile Lines

H O Type here to search




7. Creating the 2D Flow Area

From the HEC-RAS interface, click on View/Edit Geometric Data X<| A new form will
display entitled Geometric Data. The surface will initially display with the colours
representing elevations. To show the aerial photo, click on and tick on to display

the Map Layer you added.

#» The linework (Create in 11D model) in your original drawing can be included in the
Geometric data as a layer, after exporting it out from the drawing in an appropriate
format for HECRAS. Now to create a 2D flow area for analysis. To keep it simple,

select the extents of the - terrain as the boundary.
Area
€D
» Click on the 2D Flow Area button. Use the left mouse button to

sketch the boundaries of a flow area. Double click on the start of the first line drawn
to close the area.
» At the prompt, name the area 2DArea and click OK.

R — o
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ols GISTools Help

4 N\ Tools R e Sorape [“20w 34 .‘EDPmez sA2fres Bamm?i 2D Ared | ‘Desumuﬂ Plot WS extents for Profile:
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1 Junct: ._.I
T e
| Crose
Section
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Inline
Structure|
4 I.éleral
Structure
st
=
] 5
2DFk
1 s
$A/2DArea)
.CTD' Enter the name for the new 2D Flow
— Area (16 Characters Max),
Pump
Station
| HTab ]
Param
Wiew
Picture J
il =

[ 250828 84, 3402362 84
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Fig 49

# Left click on the new area and select Edit 2D Flow Area.

» Inthe 2D Flow Areas form you apply a computational mesh across the surface, as
well as establish Manning’s ‘n’ values to apply for the default area and for any other
Land Cover areas added. Click on Generate Computation Points on Regular Interval
with All Breaklines. Set DX and DY both to 50 and click Generate Points in 2D

Flow Area.

2D Flow Area Generate Points

2D Flow Area: |Total Flow Area i ) .
Computation Point Spacing
Connections and References to this 2D Flow Area
Spacing DX = 50
Spacing DY = 50]

Shift Generated Points (Optional) -

Shift Right = F
‘ shift Up = T
Defaullt Manning's n Value: 0.06 _
Edit Land C to Manning's n... Current mesh r -

— e I Generate Points in 2D Flow Area [ Cancel [
Cell Volume Filter Tol(m): 0.003
Face Profile Filter Tol{m): 0.003

R Prifle Fr. T Generate Computation Points on Regular Interval with All Breaklines...

Face Area-Elev Filter Tol(m): |U-DU3

Face Conveyance Tol Ratio: 0.02

|
|
View [Edit Computation Points ... I
Force Mesh Recomputation l OK I Cancel I

Fig 50

» Click OK to close the 2D Flow Areas form. The pattern on the 2D flow area in the
Geometric Editor will change — zooming in will expose the individual mesh areas.
Zoom in to view the mesh shape. If any are red in colour then you will need to use
the Edit > Add Points command to add more mesh point or else adjust the boundary

shape.
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Fig 51
8. Setting Boundary Conditions (for Incoming and Outgoing flows)

Flow comes from northeast side, so inflow boundary condition has been set on this side and

outflow boundary is set on western side. To set the boundary condtion we use the following
steps:

HEC-RAS
» Click on the SA/2D Area BC — T
i titer the name for the oW Area Boundary 0
Lines 3’;’52?2‘23 Condition Line [max 16 chars). <
button | Cancel

» Click along the

northeastern boundary to set | |flow

an incoming flow line. Double
click to finish the
boundary. Fig 52
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> Name the boundary Inflow and click OK to create.

> Repeat the above 3 steps to create an ‘outflow” boundary. Run the boundary along the
western boundary where the properties are and name the flow area boundary Outflow.
Outputs should look similar to below:

|| "< Geometric Data - geom1 - | b4

|- File Edit Options View Tables Tools GISTools Help
Storage | 2DFlow sapanm;lsmannm 2ﬁﬂre=1 20fnea
rea rea i S

Com | B Lines [Eresklines mannin
D | 2 | DI Regions

= Description ¢ Plot WS extents for Profile:

RS .
| | Al -]

Tools  River
Reach

[\Editors =

:o@é}

Pump
Station

o

Inline
Structure

Lateral
Structure

i

i
e
2DFlow
firea
SA/20Area
on
=z

Pump
Station

HTab
Param

Wiewy
Picture
20

=a| L+]

‘ 2576826 46, 3404613.54

Fig 53

» Click on File > Save Geometry Data.
» Name the file Existing Conditions and click OK

9. Edit unsteady flow data and assign boundary condition data. In our case we use daily flow
hydrograph data (for inlet the water from upstream) and normal depth is used for
downstream flow data. Save unsteady flow data.

10. In HecRAS go to run command and then click on Unsteady flow analysis option and save
the plan. In this case assigned the time period of model to run.

11. In RasMapper computes 2D flow area. If any error is occurred to set the time parameter in
unsteady flow analysis option of run command.
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Click on edit connection, Connection Data Editor window is open
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